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JE—REFETX v E—I SES/(—DK
TENET,

JE—D5ETIdE. TLARAIVEEICR
DET,

AE—ZRILET DI
RESET/RETURNRY V73L& I
JE—7%ZFIEL T, T LARAVEEICRD
e

Uy T7AI)VE—iE1E—
gBIclE

BIUSXSXEYU—H— RICETERSNTVSD
U v T, FIDSXSXEYU—H—RICE
EHTOAE—TBHIENTEFT,
HDE— NESDE— DI Y w THYEHER
FENTVDSXSAEU—N— KTl ]’
AERSNTVDE—ROIU Y TDdH
E—&NEITDT. B—FE—rDIUvT
DIHE LW E EICHERNTT,

Ffc. GeneralZ« LI bU—RADT 7 A )L
Z#oUy TERICEIF TV Y TE—HEIC
—EIE—TBHEHTEFT,

1 YoxqEECIE—335Uy T
DY LZAIEBRL. X=1—0
THUMBNAIL >Copy All >All Clips%&
BIRT B,

[Copy All Clip?] DHERAvE—IH

RREINEFT, ﬁl}l
2 [Execute] Z##EIRL. MENUDZEH o
E;ﬁg—o -
OdE—DREDE T, tl,
JE—HTHIEEFKRDIRRINE 55
ER =

HDE— FTHEITUBEF. HDE—
RDIUwTDHIE—ENFT,
SDE—RTHEITUBEAIE. SDE—F
DoUY TDHIE—EINKT,
m[=e LA
RESET/RETURN/RY VZ#H LK T,
JE—HRT LIRS
eI Xy E—IHRRTIN. THUMBNAIL
AZ 1 —BEIBRRSNE T,

GeneralT« LI NU—RADET 7 A
WZEIE—73ICIE

Uy 7 IAE—ULIEWTT 7 A )LDH—
FEIE—9215B5(F. FIE1TTTHUMBNAIL
>Copy All >General FilesZEIRUFE T, 7
Uy T7ETPA ) ZEHEC—EIE—T
25E(F. FIEITTTHUMBNAIL >Copy All
>All Clips & General FilesZZ#RUFE F
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Uy J&EIRT S

SXSAEU—H—ENSTU v T =ZHIFRT
BDIEDNTEFT,

| TR

OKR— 2 B IIZHDZ U v TR T &
Bhoe

Bl LIz &1, SEICOKR—2 ZMIBR LT
FEED (104x—YBER),

1 voxsLEETERTZIU Y TE
FRU. X=a3—OTHUMBNAIL
>Delete ClipZ#IRd %,
50y T ORMEREEICTID DD,
REBED FICHEREA v E—IhERe
n#v.

2 TExecute] ZERL. MENUDEH
E|T,

S0y THEIBRENET .

YLRAIVEETE. HRLZZU Y TD
RUEDM DT DIED LD E T,

IV y TR B ICIE

B USXSXEY—H— RICEHERSNTLD
Uy TZEREOTHRT DI ENTER
ER

| TR

* HDE— RESDE— RO U Y THURTES RS
NCTVBDSXSATEY—A— RTlE REERE
NCVBDE—RDIU Y TOHEFRENK T,

* HDE— R THIFRZRITUTH. OKNY—I D\
menreo Uy TIFEBRESNE B A

1 vaxsLEETERTZZU Y TD
B LRAIVEERL, XZa1—0D
THUMBNAIL >Delete All Clips%:&iR
ER
[Delete All Clips?| DA vtE—Y
HERSNET .,

2 TExecute] ZERL. MENUDEH
ZHY,

B LRAVERE

HIBRHMAER O & T
HIRSETRRESRR DR RENE T,
HDE— RTETUBAEIE. HDE—
RDOU Y TOHEBRENFT .
SDE— RTETUIBARF. SDE—R
DUy TOBYFFENET
HIRZRE g 2 IC(E
RESET/RETURNRY VZ#ULE T
HIBRDSE T LTS
SEr A Y E—IDPRRESN. THUMBNAIL
A1 —EALBRRENET,

IORINY RY L3RA )VEEZE
KRNI D

TORINY RS LRAJVEETlE. LR
AIWT—=F (IR—IBHR) PRREDZE
B (109X—I8H), Y3y hx—ID[
M/ BIER (108R—IBH) ZTDTLD
TEEY,

KRNI BHICE

YLRAVBEECY LRA)L7ZERU.
EXPANDIRY > (24X—IUBMR) #iRg
. XZa2—@OTHUMBNAIL >Thumbnail
View >Forward ExpansionZZRUF 9
BIRUEOU Y TDI ORI RS LRA
JVEERRSINE T,

HDE—ROI IR\ RY LA
JVIEH

HDE—RTIlE. FRUEOU Y TZRET
1208ILIe&T Oy I DEET U— LAY
LRA)NRRENET,



BRENTLS IL—LOBES

{TIm120min EXPAND GLAS 0000129))

o 1 1
P ] 01:10:20:00 01:10:30:00  01:10:40:00 01:10:50:00

- !

Yoo

. ‘ '
01:17:00:00 @ 07:11:10:00 ‘101 11:20°00 o1:11:30:00
EEy - - q
‘;1:11:40:00 - 01:11:50:00 ;m wz?‘oa 51 - i
01/JAN/2009 10:53 S&Q Motion 29 JCR 01:10:20:00)
JPANO011(1) @  HQ 1920/24p(@ B III iln‘llnﬁm
1

2

BEE MRICo Uy TOFRIERNERRSN
EED

TEOEBMANE. BEOY LRAJLVEE
TRRSNBDIEREFHETT,

QO TL—LIER
BRULTLU—LDBRET A IV THRR
LEF.

KB

.

Y3y bY—=O1BMIIMENe T b—L4A

m 3w =220l Nfc 7 b—LA

FNZNDY LARAIEHDFICBRE LT
A AVHARREINET, 2L, BUY
U—LICEBDERAMMIIENTVDIES
[ClF. KFE—-Y 3y bNY—T1-Y3v b
N—U2DBEIEM TCRRINE T,

O Y4 L1— KRR
TORINY RO LARAI)VEEmCRIRULIET
U—LDIA LTI—RERRUET,

SDE—RDIIRINY RY LRA
JVEIE

SDE—RTIE. T7AILTA XH2GBZHE
A CHEREFESNT U Y TDHEDH
DEISNIET 7 A ILDFEEDT U— LD
LRAERRENFT T,

BRENTVWD TLU—-LOES

{I120min EXPAND (6] D)

00:00:00:00 00:09:30:00

00:19:00:00

01/JAN/2009 10:53

JPAN0011_01 DVCAM30P SQ

([CR00:00:00:00)
l- 00:09:30:00)

1 2

BIE MBICT Uy TOFRERIERR SN
ED

TEDOEBMAE. BEOY LAXRAJVEE
TRRSNBDEREHETT,

Q@ Y1 L1—RHRR
BIRESNTLDREI SN T 7AILDS A
LOd—RZERRUED,

© RE5RI (Duration)
BIRSNTWVDREISNTE T 7 A4 )LDINER
FREZEXRRUET,

SEEEEPTICIE

EXPANDIRY > ZHIH . XZa1—D
THUMBNAIL >Thumbnail View >Forward
ExpansionZBIRT &, DEIRRINT
WaoUw T/ TJ7A)UhRECE 512
PEIINFT (1208 LIco Vv T/ T7
A 7ZEEHIC127EI LT, 12X12=144%
2. BUBRMEZREDRLUT, DEI#ZED
FENTEFT,

1ERPERI DD EIICR T T
SHIFTRS > % U e X FEEXPANDR Y
ZITH., XZTa1—DOTHUMBNAIL
>Thumbnail View >Back Expansion’i&iR
TBHE. DEIEN 1 EBEAENWI O R/
R LARA)VBEEICEDE T,

Y LA )ERE

=S

PELANG
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Yay NN—OY LxA)VEE
#XRT9D (HDE—RDH)

Y3y bN—UYLRA)VEE (HDE—F
BDHET) TlE TLRAIYT—F (97
N—UZH) PAKEOEE (109X—Y

ZR). Y3 v bY—U DR HIBR (108
N—UZR) ZTDIENTERT,

1 YLzAIEETY LA IV ERR
L. ESSENCE MARKh% > (26
N—IEHR) ZHTh. XZa1—0D
THUMBNAIL >Thumbnail View
>Essence Mark ThumbnailZ:&{Rd
%o
V3w MNN—0Y AXRAJVBEEDHERTR
TN BIRUX MDRRESNFE T,

2 IytYRI—OYLRAIEED
ERZERT S,

Al : Ty AX—oMImaNe>
=L gRTH LRAILRRE
nxd9,

Shot Mark1: ¥ 3 v bXY—2Z 1030
NV T —LDIHT LRZAI
RLASNET,

Shot Mark2: ¥ 3 v bY—2Z2H0M3 0
NV T —LDIHTLRAI
RLASNET,

Shot MarkO& Shot Mark3~Shot Mark9

DHEIRTEFT,

3wy hNN—20~Y3v hN—290D

REEERUC IS VIV IXTT—

SYERFBALTO Uy JEERUCEE

&, U hDFERIBENTER UTc2E]

[CIEDFET,

Y LRA VB

v aw bN—0Y LA JUEES]
(Shot Mark1:EiRES)

BIE MBICT Uy TOFFRERDNRRSN
ER

LIFOIEBRSE, TR R LRA
JVBECRRSNBIEEEHETT,

Q@ Y1 L0—RER
V3w MNN—0YLXRAJVEETEREN
TWBIU—LDY A LO—R

Y av b—U%ENHIFRY
% (HDE—FR®DH)

Y3awv MN—IJYLZRA)VER (108X—
IBMR) FIFIT ORI RS LRAIVE
® (106X—IBH) Tld. HDE— NTHC
JUOUYTDERD I L—ALICT 3 Y
hr—oZBMUIED. EFINTVD
Y3y MN—UZHRITDENTEFT,

Yay bY—0%ZENMTBICE

1 vavbrv—omEMLEVWIL—L
DY LRAIEBRL, X=1—0
THUMBNAIL >Set Shot Mark >Add
Shot Mark1 (FfzldAdd Shot
Mark2) ZERT D,

IR Uiz T L — LDl R EmE(C
D. BROTFICERX v bt—IhER
INET,



2 ExecuteZEIRL. MENUDEH%
Y,

Yay bY—U%ZHIIFT BICE

1 vavrv—o%BRBELIEVWIL—L
OYLRAIEBRL, X=1—0
THUMBNAIL >Set Shot Mark
>Delete Shot Mark1 (ZFfcldDelete
Shot Mark2) %#&iRd 3,

SBIR U T U — LD REE(C
h. BEROTICHERX v t—IhER
ENET,

2 TExecute] ZEIRL. MENUDEH

=T,

IV TORKREEEET D
(HDE—FR®DH)

HDE— DI Uw TITlE. TR RS
LZRA)VEE (106 R—IBH) P 3 v

=Y LZRA)VEE (108R—ISH)
TERUETU—LZRKRBICRETD
ENTEFXT,

1 RFECLIEVWIL—LOYLRAI
EBIRL. X=321—0OTHUMBNAIL >
Set Index Picture%=2&iRd %,

BIR U 7 U— ADFEMZNEE K
b. EGDOFICERA v E—IhER
ENET,

2 TExecute] ZERL. MENUDEH

ZHY,

| TR
BUSDTL—LEREBCREL TS, YA
A VB CR4 2B LTS B3, #ICKEE
L—Lh SEESNET,

Vv T%53EI9S (HDE—FR
Dd+)

HDE— DIV v IE. TIRIY R LA
FAIVEE (106R—IBH) P 3wvh
N—UYLRA)VEE (108R—ISH)
CTERLICTU—LMET2DD7 Uy T
[CHBTDIENTEET,

1 saLrEBcSR? T7L—L0Y
LRAIVEBRL, X=21—0
THUMBNAIL >Divide CIip’E@R?
2.

SEIR U Te T L — LD R B 75
0. EROFICHERA v t—IHER
ENET,

2 TExecute] Z®/IRL. MENUDEH
BT,

BRI DL — LB THEEN. 2D
DRIDEFID S U v T Heme
nEv,

2w TR2DFHFAXFEFTDT U W TDH

HIZS|EHE, BIANFERIDERES

[CEDFET,

Bl Friz(CERER UIcB A ICEFGHO100& L)
SUUYTIHESNDIREET.
ABCD0002&E WS EHID D U w T4y
2|LfeisE. ABCD0O100&ABCDO101
D2DDT Uy THMEREINE T,

| TR
SSHEU—H— ROBER, 21y THTH
BLABIORLELBAE. BETREASES
Xy b= IBRRENET

Y LRA)ERE

=S

PHLANG
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MRE_T "X =9

M

110

6n PEEER T IR

Yy NPy ITA=Za1—
DIBRk L MEE

THTIE, Ea—T 74 VI —EEICEKR
SNB Y b Py IAZ1—=REALT,
BETPBEICHELERBOREZITVET.
Ty P YvIXZa—F HEBETAHEZ
Y—CRRTD (157TR—IBH) &b
TEFY,

Ty N7 Y TIAZ 1 —DiERK
TEDAZ1—THERINTWVET,

Op : OPERATIONXZ1—
EEMNDIRFE(ICET DREZTVET
(15R—=IBR),

Pa : PAINTXZ=1—
HEICEAITDIREZTVET (126R—

Th : THUMBNAILX= 21—

51y IO LR A VBT BREETL
=T (99R—IBH),

| TiER

THUMBNAILX =1 —(&. T L3 JUBIE (93—
IBR) ZRRUCVD EEDIMERATETT . U
LA )VEEZRRUCVWEVNE EFENTT,
Ma : MAINTENANCEX = 21—
F—FAHESA LT~ RICET 2RER
AVET (131IR—IBH).,
Fi:FILEXZ1—

BIE D7 AVBEETVET (143%—Y
=08

= 5w/ o

Ty Py IAZa—DEH SR

ty N7y TITAXZ 1 —DEE

@ THUMBNAILX Z 2 —D#EMIC DTl
[THUMBNAILX Z 2 —#m] (99—3)
ZECBLLEEL,

OPERATIONXZa1— (115R—Y&
8R)

OPERATION

Format
Format Media
Input/Output
Super Impose
Rec Function
Assignable SW
VF Setting
Marker

Gain Switch
TLCS

Zebra

Display On/Off
Auto Iris

White Setting
Offset White
Shutter Select
Time Zone
Clip
Plan.Metadata




PAINTXZ21— (126X—IEHR)

PAINT

MAINTENANCEXZ=a31— (131~R—

e

MAINTENANCE
White Shading
Battery
Audio
WRR Setting
Timecode

| Switch Status
L White

Black

| Flare

I— Gamma

| Black Gamma
Knee

I White Clip
I Detail(HD Mode)
I Detail(SD Mode)
I Aperture

I Skin Detail
I Matrix

——— Multi Matrix
—— V Modulation
Low Key Saturation

Preset White
White Filter
Auto Iris2

Genlock
ND Comp
Lens

Wi-Fi Setting
Clock set
Language
Hours Meter
Version

Essence Mark
Camera Config

Flicker Reduce

Trigger Mode
Network Setting

FILEXZa— (143R—IEHg)
FILE

All

Scene

Reference

Lens

ow

pd

Ty Py IAZa—DEH SR

WE-TZX =9

ATEME
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Tty b PYyIoARZ2—
DEXRIRE

Ty NPy IXZ1—ZRTITD
(&

MENU ON/OFF XA wF7%ZONICT & h
MENURS V7ZHLE T,

AEPA Z21—F— FITIED . EECX
Za1—URXPHERREINF T,

BIEERE LTeX Z 2 —DEXF 2XF) I
A=V IVHRREN. BITHITT D X
Za1-EEBERIU7ZHRRSINE T,

5] : OPERATIONXZ=a—ICHh—=VIL
h&H 315
AXZa—UR B
l OPERATION

n l{Format Media
via [l Input/Output

i @Super impose

XZa1—IREERTVU7

==
KT 4 —HA (Focus Mag) E— RICIE>TW
BEBY NP YTIAZI—([FRIETEFE B A
Focus Magh'glb ¥ ToNTWS 7 YA+ TILR
AYVFTHRIT A —HRAE— REFRLTLEE
(AN

XZ1—ZRETBICIKE

1 MENUDZEBZEETH. 4. SRSV
EBUT, ZELELWXZ1—[Th—
VILEEDE D,

A AVADAZa—IEE&ERIU
[C. BIRCTEDAZ 1 —BELFRS
n#v.

Ty hPwIAXAZ 21 —DERRE

2 MENUDEHEIIXSETRY V%R
g-o
H—VIUDIAXAZ2—IBE&EIRTU(IC
BELET.

SRSV EBLTH—YILEXZ1—

EEZBIRTIUVICEHSTDHEDHTE

=9,

o X1 —IEEERT U PIFRATTE
RTY. BIRCEBIEEN—EICE
MCEFEWVEEIF. A—VILZELET
[CBETDHEXRINDRIO0-)LUE
7,
EERRTU 7OA REEAT
BE(C. RYO—ILERET S ERY
=ABY—UhRRINET,

__ OPERATION

] Format
Th @ Format Media
Ma [l Input/Output

Fi lSuper impose

XZa1—TEALFETICHD
EERTENZT (LICHD
EERFHRICA),

A= 21—TEERIRTU7
* ESICHREMEEBINT ZBEADEAE.
AIIPHRREINZET .

s WREOBVERDSA. AICREDS
EENFRRENET,

s DEBRTDE—DLOEEICRDE
9,

3 MENUDZEHEETH. 4. KIY

ZRLT. BELIWXZ21—1EH
IChA—VILZEEDE. MENUDE#
FFSETRY VZRUTRET %o
A Z1—IEEERIU7OGEICREL
U7DRRSN. A—VIVHEEROM
BHICBEBULET,



__ OPERATION

HD System Line : 1080
System Frequency : 59.94i

Rec Format : HQ 1920
Aspect Ratio (SD) : 16:9
J Country : NTSC Area )

BETUT

o HEEREDREBEIRRENETD.

o DERIHERY VEHT, FelF
MENU CANCEL/PRST/ESCAPEX A v F
ZESCAPE/IICIE U R FDE—D DR
CROET.

MENUDZE#ZETH. 4. dRFV
Z|ULT, BELEVMBICH—Y
ILEGDYE., MENUDEHETIE
SETRY VEMU TRET Bo
FIRUCHBORIREONERRSN. 1]
ERIRSNTWLDEICH—VILHES)
LET,

__ OPERATION

Op P}

1 Format

Th i Format Media

Mz @l Input/Output

7i @l Super impose
Rec Function

»
»
»
»
»

Aspect Ratio (SD) :

Assignable SW » _§Country

BIRETU7

BIRFETUP[FERKR7{TRRCY, =
RED—E[CRRTELFEVEE(E.
H—V )7 L FICEET D EFRRH
AoO0—=-)LUFT, ERFEIUFZD
G LBFRFETRIC. Xo0-)b
TR C EFERT =AY —IDERR
SNFEY,
BIREOEENATVIERDSS
(Bl 1 -99~+99) (F. BRETUF
[FRRSNFEBA. XFEH/\ASA
NRIRICIE D SR EZEE D A BEIRIRRE
THdEETRUET,
MENUDEHZETH. ¢, JIKFY
ZHUT. BEULREWEZREU.
MENUDEFEHEIEIXSETRY V& #
ULTRET %,

BRENEEIN. BEERDIRENERR
TNEY,

S21TIEE CExecute ZEIR LI B E(E.
ST DREEEDEITINE T,

KITRI[CHESS D R RISIER Tl

FIES T, KITHICHERDLEFIEEZER
FdE WofcAXZa—hVHR. SR
Xy E—IPRREINE T, XvtE—IIC
LichioC. RITFdnFvr/Ldsdh
ZERUTLIES VY,

NFEANTBICIE

FALT=EIPT7AIRIEE, X7z
RETHEEZERRUICBEE. XFHD
ANTUTHINA T4 hRRITIED. Bl
[CSETHRRENE T,

1 MENUDZBEETH. §. IKIY
EHLT, XFEBRL. MENUDE
HERIFSETRY VERUTRET
P
A—VIVBROMBICEE LET .
BIOWICEDTcWLWETE. MENU
CANCEL/PRST/ESCAPEXR A v F7%&
ESCAPEIICIRUTRIFE T,

2 AECREON  METHET 3.

A—YVIUBSETICES LET.

MENUDEHFECIFSETRY V&

T

BEHSET LET,

w

REXEZRDHTICIE

MENU CANCEL/PRST/ESCAPER A v F 7%
ESCAPERIICH U TIFE T,

BT (T (=Y (U
Tty hg3) [CIE

1 seszEvmEEdgessszn
b;EU#IC. MENU CANCEL/
PRST/ESCAPER A v F7&CANCEL/
PRSTHIICIRUL EIF3.

2 BEOSTEELNT (HRTEE)
[CUtY NTBHESHERRTD

Ty PV IAXZ I —DERNRE

WE-TZX =9

ATEME
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KTbHES, BEXSAvFE
CANCEL/PRSTIICHRUL EIF 3,
REDRENMEERTEIC Y b
*x9,

XZ1—BFERTIBICIE

MENU ON/OFFR A v F%ZO0OFFICT %
HMENUIRS V%9,
BEDHATEICRDFT,

MRE_T "X =9

M
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AZ1——8

OPERATIONXZ—1—

AFCTRRSNTVDREEF. HEROYMHREE T,

OPERATION

(=] b= IR ABE

Format HD/SD HD/SD E)EE— REHDE— RETzIFSDE—
TEDEEE— RBKU RICYID#RZ D (Execute TEAT)
sLi% 74—~ v MERE HD System Line  1080/720 HDE— RESDEEREE1080F /i3

LET,

720ICERTET B (Execute TEAT)

System
Frequency

HD/SD. HD System
Line. CountryMz&
EICHUTEDD

DRAT LEREEEIRT % (Execute
THRIT)

59.94i/29.97P/ HD/SDD&ZEHHD. HD System Line
23.98P MEXTENH1080. CountryDEREHPAL
ArealIHADEE
59.94P/29.97P/ HD/SDDEREHHD. HD System Line
23.98P MEREHT720. CountryDsREHPAL
ArealIHADEE
59.94i/29.97P HD/SDDERTEN'SD. CountryDEREN
PAL ArealISAD &
50i/25P * HD/SDDEXENHD. HD System
LineMEZEN1080. CountryDEZTE
HPAL AreadD &=
* HD/SDDEXEDSD. CountryDEZE
HPAL AreadD &=
50P/25P HD/SDMERENHHD. HD System LineD3&E

720, CountryDFRENPAL AreaD&E

Rec Format

HD/SD., HD System
Line. System Frequency
DFEICHUTENSD

SR+ —< v hEBRIRT D
(Execute T51T)

HQ 1920/HQ 1440

HD/SDD&ZEHHD. HD System Line
MDFFFEHN1080. System Frequency®D
REN29.97PFH fc|F25PD & FE

HQ 1920/HQ 1440/
SP 1440

HD/SDDEEENHD. HD System LineD
SRTENYM080. System FrequencyDERiE
h29.97PE KU 25PLISND & &

HQ 1280 HD/SDDEREHHD. HD System Line
DFRENT720DEE
DVCAM HD/SDDFEENSDD & &
Aspect Ratio 16:9/4:3 SDE—FK E&HI4—Vwv hE
(SD) DVCAM) D7 AR M7 2IRY %
(Execute CS=AT7)
Country NTSC Area/NTSC(J) {ERH#IEZRET D (Execute THEIT)
Area/PAL Area

XZa1—8

WE-TZX =9

ATEME
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OPERATION

1HH e EIREL AE
Format Media Media(A) Execute/Cancel 20w RMADSXSXE ) —H— RZEHJER
ATFATDT =Y b {£9% (ExecuteTSRIT)
ERTLET. Media(B) Execute/Cancel 20w NBOSxSXEU—F— R&#H
{£9% (ExecuteT3E{T)
Input/Output Output& iLINK  HD&HDV/SD&HDV/ ZFFAHFEEILINK (HDV/DV) HF
A/ HHESICET DR SD&DV/480P (576P) 5 DHESZEEIRY &
EZITVET, o HD/SDDFRENSDDIHZAE. SD&DV

BRSNS

e 480P (576P) (&. CountryDs&EH
PAL ArealllSADIHE(F480PHYEIR
AJRET. CountryDiZENPAL Area
DIEAIF576PHSEIRTIAE

23.98P Output

PsF/Pull Down

EFF 74+ —< v MHHQ 1920/23.98P
FTzlFHQ 1440/23.98PDIBE(C. 70
Iy T4 (PsF) (CgDh. 7
LA DA (Pull Down) ([CFDH7%
BRI D

Source Select

Camera/i.LINK

EFFANY—REAXSHE
(Camera) (92 H.LINK (HDV/DV)
HFNODAINES (iLINK) [CTD
H7ZEIRT

i.LINK 1/0

Enable/Disable

i.LINK (HDV/DV) imFDESALEH%ZE
B3 (Enable) (CT 2D R
(Disable) ICF2hERIRT D
Enable®@iRES (&1 LINKHE (T A — b
TSV IINTURERITTED,

SDI Output

On/Off

HD/SD SDI OUTiwFHh 5 DHFIESZ
X/ FTID

HDMI Output

On/Off

HOMIIRFOSDENIESZEA > /7
J9d

SDI/HDMI Out
Super

B9

On/Off

HD/SD SDI OUT#zF &HDMItRFH'S
DEHICA—)\—AVIR=XENBDX
FIEREL > FTTD

Video Out Super

=X

On/Off

VIDEO OUTIZF A SDHAICA—/)(—
A VR—ZAENBJXFEREZL >/
A79%

Down Converter

uog—T

M

Crop/Letter/
Squeeze

SDIEBZHNT B EEDESERE—

RZEHRET D

Crop : 16:98&DmiHZE Y ~ULT
4:3ERE L THA

Letter : 4.3ED L TFEIY AT LT,
EERR(C16:9M R E KT

Squeeze : 16: 9817z 73 ECHE/N
U T4:3E#RE LTHA

Wide ID

Through/Auto

SDHEAMESICTA REBIESZMINT

BHNEDINZEIRT D

Through : DA RERIESZMIIET
[CZDFFESHTD

Auto : Down Converter®DEREH
SqueezeD&EE, EFAHESICTA
RBRIESZHMULTHAIT D
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OPERATION

15 e EIRE: nE
Super Impose Super(VF On/Off Input/Output >SDI/HDMI Out Supersk
ZA—)—~A v R—Xan Display) fzl&Video Out SuperMsRENOND &
DIFIER /X —H—IC Super(Menu) On/Off ZF(Z. HD/SD SDI OUT#%+. HDMIig
B9 2R EZITVE T, : FEFVIDEO OUTIHFH DI
Super(Timecode) On/Off 2—)— A U R—ZEN B IER%E.
BECEICAY / FTTD
Super(Marker) ~ On/Off Input/Output >Video Out Super/*On
MDEFE, VIDEO OUTIHFH DI
A=)~ VIR—XENBJIY—H—%
NEAV/HTITD
Super(Rec Status  On/Off TED2DDENICEFIKRR R E X —
Indicator) IN—AVIR=XFDHESIHEA VIF
J79%
o Input/Output >Video Out SuperhH®
OnM EEDVIDEO OUTIHRFH D
£
¢ |Input/Output >SDI/HDMI Out Super
HOND & EDSDIifHF & HDMIijBF
oD
Rec Function Slow & Quick _ On/oft 2O0—8IAVIE— 3 VE—RE

K IRE— NICBT D
REZTVNE T,

X2/ ATFB
(CDEREZONICT D& Picture
Cache Rec. Interval Rec. Frame Rec
DEREMOMICIED,)

PIAFTIVAA v FIC Frame Rate
Picture CacheZ 2| D24
TdE. COERGER
(JU—FR) [TEDE

o

Format >HD System
Line@DEREICHRUT
ZHd

Slow & QUICkDERENONDIFE(I, R
O—8&0A4 Y IE—Y 3 VBERKDD
L—Ll—hrERETD

Format >Country®
SREDPAL Areal:l
1 1~30

Format >Country®
SREDPAL Area : 1
~25~30

HD System LineDs&EN1080D & E

Format >Country®
SRTEDPAL Arealsd
1 1~30~60
Format >Country®
SRTEDPAL Area : 1
~25~60

HD System LineDa&EN 720D & E

Picture Cache
Rec

On/Off

EOFv—FvrvIalvIE—RZE
T/ ATID
(CDHREZEONICTDE. Slow &
Quick. Interval Rec. Frame Rec(D3%
ENOfICIED,)

P. Cache Rec
Time

0-2sec/2-4sec/4-
6sec/6-8sec/8-
10sec/10-12sec/12-
14sec/13-15sec

Picture Cache RecDERTEN'ONDIBE
IS EO9Fv—Fvvialby ol
ERETD

Interval Rec

On/Off

A=)y OE—RZEF >/ F
J9%

(CDHREZEONICTDE. Slow &
Quick. Picture Cache Rec. Frame
RecDEREN O Do)

Frame Rec

On/Off

JU—LUYIE—RNEAY /ATT

v

(CDHREZEONICTDE. Slow &
Quick. Picture Cache Rec. Interval
RecDEREN O Do)

XZa1—8

WE-TZX =9

ATEME
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OPERATION

15 e EIRE: nE

Rec Function Number of Format >HD System |nterval RecZEzldFrame RecDIREN
$SIRECIRT— NICEI gD Frames Line. Format OnDBAEIC. A VF—=)UbLy TIRE
WEZITVET . >System Frequency ZFfzl& 7L —LAL v 7 BEBED1EIDED
= DFREICIHUTED fIU—LBZRETD

2

FHAFTTIVAA wFIC
Picture CacheZ |04
TdE. COERIGED
(JU—FR) [CEDF

o

2frame/6frame/
12frame

HD System Line®M3&EH720. System
FrequencyDEREN59.94PZK fz(F50P

1frame/3frame/
6frame/9frame

HD System LineDE&EN 720U}, &
fzl&System FrequencyDEREND
59.94PE K U50PLIAN

Interval Time 1/2/3/4/5/6/7/8/9/10/
15/20/30/40/50
(sec)
1/2/3/4/5/6/7/8/9/10/
15/20/30/40/50
(min) 1/2/3/4/6/12/
24 (hour)

Interval RecDERENONDIHZAIC. A
25—Vl Z iR R ORBERRE
(A 5—=NN)L) ZREITD

Off/2sec/5sec/
10sec

Pre-Lighting

A2 5=y JiRFEIRRIICET
54 hERIS B 2BEHITRFE]IC
RAOSEDINEER, RIISERENE
B0 7ZEIRT D

Assignable SW
PHAFTTIVAA wFIC
HEREZEID 1 TH T,

@ HEREDEIOHTICD
WCELLIF. [P
AT TIAA vFIC
HREZEIDZETS ]
(146R—Y) =CTE
<fEELy,

B9

=X

2Z—T

<0> 146R—IU 1
<1>
<2>
<3>
<4>
<5>

RET

C. Temp

ASSIGN. 02 A v F(CH#EEZ B D HT
)

ASSIGN. 121w FICHREZEIDZET
)

ASSIGN. 221w FICHREZEIDZHT
)

ASSIGN. 3R v FICHREZEIDZET
)

ASSIGNABLE 42w F[CH#aEZEID
=)

ASSIGNABLE 52 1w F [C#EEZ | D
HTD

LUV ZDRETRY V CHREREID T
)

COLOR TEMP./R& >/ [CHEEZEID Y
&)

[

M

Zoom Speed 0~20~99

ASSIGNABLE 4FfclF5X A wF(C
ZoomZB|D HTIBEDAX—LR
EF—RZEEREITD
PMW-320KICIB Y %L X7ZER L
eBa. BEX—LBICOSAHED T
EDHDFRT,
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OPERATION

IRE =]

EREX

RE

VF Setting
Ea—J7A VY —EE

Color

—99~+0~+99

Ea1—J7A VY —BEHEHICKRRIND
BREDBEDRSZHET D

[CETDREZITVE  Mode

o

Color/B&W

Ea—J7A VY —BEEDRREN
Z— (Color) [CT2DHEE (B&W)
[CTHhERIRTD (ARICHRELE
BaH. YU—PYLRAI. RFV
T—brDIUPIEFNS—TRRIND)

Peaking Type

Normal/Color/Both

E—F JDBERREIRT D
Normal : BEDE—+> T
Color : h5—t—F27
Both : M@}

Peaking
Frequency

Normal/High

E—F U IEREBERE (Normal) [C
gBdnE< (High) T2H7EERT D

Peaking Color

White/Red/Yellow/
Blue

Peaking Type®DsZEN ColorDiZE [,
E—F+2JDEZERT 2D (White :
H. Red : 7R, Yellow : &, Blue : &)

Peaking Level

Low/Mid/High

Peaking Type®Ds%EN BothDIZE (T,
NEI—E—FITDUNIVZEE
(Low)., & (Mid). & (High) h'5:E
RID

DXF Rec Tally

Upper/Both

FIFTOE 1= 7 A5 —=ERTD

Salc. U= Tz HfZIF=a
TEDD (Upper). ERAIETMAIODES
ERJEE2h (Both) ZERT D

Marker

Ea—J74 V5 —EHA
DIY—N—RRICETD
REZTVE T,

Setting

On/Off

IRCDN—HN—KRREAXY /F T
%

ASSIGN. 2[CMarkerZZIDHTTWL\D
Ha. CORTEFENTI,

Center Marker

1/2/3/4/Off

TUI-X—H—ERTITDHEIET
DEFRZER. RxUEWEE(FOff%Z
BIRT D

Safety Zone. User Box. Guide

FrameD'OnlCERESNTLDHAE.
DFREEAVICTDEFTEFRA.

Center H Position —40~0~40 TR —N—DKHUIBZRET
v

Center V Position —40~0~40 TN —N—DEBMEZHRET
v

Safety Zone On/Off =0T 4 —V—VDRRNEL >V /F
J9%
Center Marker. User Box. Guide
Frameh'OnlCERESNTWVDIHE, &
DREEAVICTDHEIFTEFEA.

Safety Area 80%/90%/92.5%/  ©—TT 14—V —VDHEEEIRT D

95%
Aspect Marker  Line/Mask/Off T ARG N—H—"FRRS DBEF

FRAEEER. ZRUBWEEGOf

ZEIRT B

Line : BfRCHRR

Mask : Y—H—#ENDETAESL
N)L7ZERFTERR

WE-TZX =9

ATEME
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OPERATION

IRE =]

EREX

RE

Marker
E1—J7A4 V5 —ER

Aspect Select

15:9/14:9/13:9/4:3/
1.66:1/1.85:1/

N—N—DFANRT MEZEEIRT 2

DY—H—FRICETD 2.35:1/2.4:1
HEZTVET,. Aspect Mask 0%~30%~90% Aspect MarkerbiMaskDIEE. <—
(10% A7 v ) A—EBERDEFTAESLAIVICHT
BHN—H—&#EENDETAES LA
ZIN—EBVT—ITHRET D
User Box On/Off Ny O ZAN—=VIDRREA>Y /F T
ERS)
Center Marker. Safety Zone. Guide
FrameDOn[CERESNTLDHEE. T
DREEAVICTDHEIFTEEFEA.
User Box Width  40~500~999 My I2ZA—YVILDIE (Db SEE
ihE CDIERE) ZRET D
User Box Height  70~500~999 Ry IAAD—=VILDES (b5 E
TRETOER) ZRET D
User Box H —479~0~479 Ry I ZN—Y IILDFDDKE(IEZE
Position BRETD
User Box V —464~0~464 Ny I ZAN—YVIILDOFDDEBNEZ
Position BRETD
Guide Frame On/Off BARITU—LDRRZAY /FTT
)
Center Marker, Safety Zone. User
BoxD'On[CRESNTCWLDIZEE. D
BEZEAVICTDEFTEF A,
Gain Switch Gain Low —3dB/0dB/3dB/  GAINZA v FDFERENLDBEDT A
A BDYIDIRZ (TR 6dB/9dB/12dB/ MEERET B
FOREZTVET . 18dB
Gain Mid —3dB/0dB/3dB/ GAINZA v FDFREDMDBZBEDT A
6dB/9dB/12dB/ VEZEHRTET D
18dB
Gain High —3dB/0dB/3dB/ GAINZA v FDFREDHDBEDT A
6dB/9dB/12dB/ VMEEERET D
18dB
Gain Turbo —3dB/0dB/3dB/ Turbo Gaint&BEZEID X Tl 77 Y A7
6dB/9dB/12dB/ DWRA wF=FVICUleEEDT A
18dB/24dB VEZERTET o
Shockless Gain ~ On/Off 2avIURTAY (FAYDIRR
BFIC A L—XICEATID B DHkEE
TEV /A TTB
XZa—§



OPERATION

IRE

EREX

RE

TLCS
h—5)ILLALTY
O—/)LICRY BREZTT
WX,

Mode

Backlight/Standard/ TLCSESDA — ~7 A U RE— N&ER
ERS)

Spotlight

Backlight : /\v oS54 hE—R (X
AV DWEARNERD E EICRIAH
ZERT D)

Standard : ZE£E— R

Spotlight : ARy bS54 hE—FK (X
AV DWEBRICZARY 54 MDD
T:)o"CL\Zati[CEIDE‘(ﬂE@%?@@‘
%)

Speed —99~+0~+99 TLCSKDHIHMAE—R (BEHRDZ1LIC
W DRINRE) ZHRET D (EHK
FVEERINFERLED)

AGC On/Off AGC (A—KT4 23> hO—)b)
BEZEA Y/ FTID

AGC Limit 3dB/6dB/9dB/12dB/ AGCEEDERAY A /MEZREY D

18dB
AGC Point F5.6/F4/F2.8 AGCBS(CH— R 74 U AN SAGCITH

H77EZVIOIBRZ DFEZRET D

Auto Shutter

On/Off

T—bovyI—aE=ES Y T TT
%

Auto Shutter Limit

1/100/1/150/1/200
/1/250

A—bov v —BDRKY v wvEF—
AE—RZEERT D

Auto Shutter
Point

F5.6/F8/F11/F16

FT—bI vy F—BHA—rPAURX
noA— b vy I—(CHIETTEZ]
DIRZ DFEZRET D

Zebra
TISHRRICET DEE

Zebra Select

1/2/BOTH

BISKRTOER (EJ351. €I5
2, FIcldmys) ZFERT D

ZTVE T,

Zebral Level

50%~70%~107%

CISNERRIDUNIVEZERET D

Zebral Aperture
Level

1~10%~20%

BIS1DTP N—F v —UNIVERET
)

Zebra?2 Level

52%~100%~109% BT 527K RT DNV ZERET D

WE-TZX =9

ATEME
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OPERATION

15 e EIRE nE
Display On/Off Video Level On/Off YR MBED I EDIEEERCIIBITED
Ea1—7J 745 —mm Warnings SODEERNELS Y/ ATITD
(XTI DIEEZERL Brightness On/off BRRDED S Z R I BBOTRES
FIo. Display SATED
Histogram On/off BEDES LANIUHTZERIEZA NI
Display SLRNEAY /FT79D (HDE—R
BF(DH)
Lens Info Off/Meter/Feet WERREERRIDHNEDIHEFRE
1722 IRT %
Off : R L7
Meter : X— ~)LFR
Feet : 74— b&RR
Focus Position ~ On/Off UYZADT 4 —HARI Y 3Rz
T/ FTIB
Zoom Position On/Off U ZDA—LRIYV 3 VERREST Y
SATITB
Audio Level On/Off FT—F A F N UAX—5 —DERRZEAH
Meter V/SFTTD
Timecode On/Off A NLNT—5 (IALT—R, 1—
H—rw bk, ADVE— Fal—
23Y) RnEXV/ATITD
Battery Remain  On/Off Ny FU—K8  ANBERRES
SATITB
Media Remain  On/Off AT A TERERNEL Y/ FTTID
TLCS Mode On/Off TLCSEWEE— RERRZEA Y/ Z 79D
Focus Mode On/Off T+ —NABMEE—RERREZEA Y /7
T9D
White Balance ~ On/Off ROA NSV RE—RERRZEAY
Mode 1793
Filter Position On/Off ND T 4 )V —REDTRRNEA > /F T
EX)
Iris Position On/Off FPAURARIY I VRRNEAY /D
EX)
Gain Setting On/Off TAVEBERNESY /FTTD
Shutter Setting ~ On/Off v wH—FE—REVPYIY—IE—
ROKRREAY / FT7TD
Color Temp On/Off EREXRREZELY /4T3
Video Format On/Off ETFFT+—NXv NRREAY /F D
EX)
System Line On/Off VATILSAVERREL Y/ FTTD
Rec Mode On/Off KEIRELERE— N&RR (S&Q. Interval,
Frame Rec. Picture Cache Rec) &7
/S FTID
Extender On/Off VAT ORT VSRR =EZ /7
T9D
WRR RF Level On/Off FIZINITA VALY —)\—DFE

UNIVDERRZEA > /A TID

Clip Number(PB) On/Off

OV TERORTNZEL > /T TS

XZa1—8



OPERATION

15 e EIRE: nE
Auto Iris Iris Override On/Off BOEBEEEHECIFBHUEHCTD
?: hPAURICETD BREZELY /HTITD
REETNET . Iris Speed —99~+0~+99 AMAC— R (BREDEILICHI DK
RE) ZREIT D (BHARKEVEE
RIBIFRLED)
Clip High light ~ On/Off SIEEEOREZEREL T, SIEEIC
W dhEi B dikeezr 4>/
9%
Iris Window 1/2/3/4/5/6/Var FT— TP AURBHED 4 >~ RODIEE
ZEIRT B
Var : A&
Iris Window On/Off =P AURRED « > RODH7ZE
Indication N——TCxRNY DtpEZA > /H7
EES)
White Setting White Switch<B> Memory/ATW WHITE BALRA v FDREHDBDLE
ROA NSV ZEEE(IC DEMEE— RZERET D
B4R EZITVET, Memory : A — R+ MISVX
ATW : BHERERRD A SV
Shockless White  Off/1/2/3 WHITE BALZ A w FHID X BRFDZ Ity

REZRET S (OfflFEEFIC/RI. 1.
2. 3OFTIFIHRBRIGHEN)

ATW Speed 1/2/3/4/5 White Switch<B>DiREDATWDIEE
DRINREZHFET D (IHRDRIGH
ELY)

AWB Fixed Area On/Off F— RO A MG YA ZBEERRE

THRITIoWEeZES > A T79D
On : EEDEEBIUMED25%IC i

DHE THRIT
Off : EEDS T BKIUMED70%I(Z5H
2B HIE CRIT
Filter White On/Off FILTERDFEHDRI Y 3 VT EITRD
Memory A MISYZAEY—EEERET D et
WasEA Y A TTD 1k
on: J4)LF—RITavTEITRD %
A RS YRAEY—BHRTE 0
off : 7 Ly—RIVaVIchhnb |
L ABDAEY —={HH |
b
el
k3
=}
&
filt

XZa—% | 123



MRE_T "X =9

M

124

OPERATION

IRE

=]

EREX

RE

Offset White

RIOA MNSVRAT
v MBEICET %8R ER
TWET,

Offset White<A>

On/Off

XEY—ADRIA SISV R(CHF T
ty MEZMIIT S (On) MUK
W (Off) ZEIRT D

Warm Cool <A>

HROBEEZRR

Offset White<A>H'OnDIBE(C. XE
U—ADRDTA MGV D
Tty hEBRETCHREID (7
v hOBRENEVNERENKEL
BBDICHERDIRGEZ BTSN S E%E)

Warm Cool
Balance<A>

—99~+0~+99

Warm Cool <A>MDETE CHLEDIRERN
BONED SIEBAIC. THITHN<
EREZREIT D

Offset White<B>

On/Off

OnlCgadECITHELIATEY b
HBF v RILDIRTA SISV R(C
MEND,

Warm Cool <B>

HROBEEZRR

Offset White<B>H'OnDiBE(C. XE
U—BDHRDTA NSNS
Tty hEBRETCHREID (7
v hOBRENEVERENKEL
BBDICHERDIRGEZ BTSN S FE%E)

Warm Cool
Balance<B>

—99~+0~+99

Warm Cool <B>MD&%7E CHLDIREN
BONEH oIEBAIC. THITHN<
EREEREIT D

Offset
White<ATW>

On/Off

OnlCgDECCTRELATEZY b
B ATWDIRD A SV AT E
na

Warm Cool
<ATW>

HROBEEZRR

Offset White<ATW>H\OnDIFE (T,
ATWDIRD A MGV RTINS 4
Tty hEERETHREID (7
v hOBRENEVERENKEL
BBDICHERDIRGEZ BTSN SiE%E)

Shutter Select
Uy —AE— R

Shutter Select

Second/Degree

Yy —AE— ROBERITEZRTE
EE)

FOREZTVET . Second : BEMICTERT
Degree : AEHMICEIRT D

Time Zone Zone —12:.00~+0.00~ UTC (JUZw IZER) HhODhGZE
REEZBRELERT, +14:00 (308fi[) Z30NEHEMCTHRET D

Clip Auto Naming Title/Plan Uy TRDEREFEZERT D

21w JDRIFPERIC Title : Title Prefix CEEICRET D
B4R EZITVET, Plan : TS5V Z VIR I TF—HTHRE
CHER TF—FTHRE UMD EWVEE

Uy TZDRIDILF
Z [.J] OFEEsIcLiEL

TLIEEL,

Uy TZDRIDILF
Il ZiEoTWd Y

Uw k. dvEa1—

Y—tDFTUT—3
VT RI TP THET
ETFB Ao

[F. Title Prefix CE%E UTcRFICT
3)

XZa1—8



OPERATION

IRE

=]

EREX

RE

Clip
Uy TDORIFPEIE(C
B OREZTVET,

1w FTR2DRIDNF
%z [.] DFESICULIEL

TLIEEL,

21w FTR2ORPDXF
Bl [ZiEoTWhd Y

UwZlE, 21—

Y—+D7TIUT—T 3
VI RDITPTHRET
ETEFBAo

Title Prefix

XFAH

Uy T2DEIA MU (4~46X
FORYF) ZRTET Do
RAERTESINTVD S A MUH8XXFLL
TOHEAEF. EXFHARREIND, 8X
FLLEDBEF, FEEHNSTNFEFRT
HFREN, BXFEDAEIC " D
SRR IND,

Character SetBEZMF-UHT .

Character SetEEDER

o XEFERTUY (317)

Title PrefixD1—V)LAIBICHAT D

NFZERT o

1#$%()+.-.;=@[]"_~0123456789

abcdefghijkimnopgrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ

o H—VIURETUT (117)

Space : H— V) IBDXF & ZAX—
RICEETD

INS : H—YUAIEIC A=A

EXS)

DEL : 1— V)L UBDOXFZHIRT D

— A=V ZEEICEETD

= A—=VILZEGICEETD

ESC: ZEZF+v)lLTEB A
—a1—ICR®

END : ZFZER{TUCEBEX Z1—IC
=)

o Title Prefixs8 LU (117)

A NVEANT DIV

F4 NMVERET DICIK

1 MENUDZEHZREIIH KEIRS >
ZI LT, MXFRIRTU 7D STitle
Prefixs% LU P DH—V ILAIBIC A
NAOXFEZER (J\A 54 bFRR)
U. MENUDZEH#HFIFSETRY >
ZY, (BRUCXFHAD, H—
VLD AICEET D)

2 FlE1ZRORL. 54 MNULEREYT
5. WEICIHUT. Space. INS.
DEL7ZFEAT %.)

3 Y4 MULRDEEDED 5.
END7%#3R U CCharacter SetEE %
U2,

Number Set

0001~9999

IUy TROESED (47) ZRET
% (12U, Auto NamingZPlan(C5%
EU. TSV IAITF—ITRHRE
LIe#IC LTWDIEEER<)

Name Display

Off/On

E-EE—REICOU v TRELE 2T 7
A VS —EHEICERRI DD (On) LK
W (Off) Z&EIRT 2.

Update

Media<A>/
Media<B>

FEIRUTWVWDROY D AT 4 7T
ERSNCBEB I 7ML ZEHIT D
(Execute T5=1T)

XZa1—8

WE-TZX =9

ATEME
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OPERATION

15 e EIRE: nE

Plan.Metadata Load/Slot(A) Execute/Cancel 20w RADSXSXEJ—H—RKHhHBJ
TSZVITAGT—HD SVZVIAI T O—RT D,
BIEICEAT REZITV ExecuteZm®EIRTDE. XOw MAD
EXB SXSAEU—N— RICREFESNTLD

TSVZVIAGT—=5DT7A()LY
ARBERRSN, T7AIVEERLT
O— RZEXR{TI Do

Load/Slot(B) Execute/Cancel 20w RBDSXSAEU—H—RHho T
SYZVIAST =5 EO— KT D,
ExecuteZ®EIRT D&, O RBD
SXSAEU—N— RICREFESNTLD
TSV IRIT—=5DT 74U
ARDRREN, T7AIZEERLT
O— RZEETI D,

Properties Execute/Cancel AEICO—RENTWd 7509
AT TF—EFDREZRNYT D
(Execute T51T)

Clear Execute/Cancel AEICO— RSINTVWD ISV Z VT
X )9 T—H7ZHETD (ExecuteTE
17

Clip Name Disp ~ Title1(ASCII) TSV VIR TF—=HTOUwTE

Title2(UTF-8) ZERTET DHADRNMAZERIRT D

(QOIR—TUBH)

PAINTXZ= 21—
KEFECRRINTCWVDHRTEEIF. HEFOYHREMB T .
PAINT
(=] e =R AE
Eﬁ Switch Status Gamma On/Off HUHIERREE A > /A TS D
BREMEMKEETAME Blackg On/Off S\ I H T A D
" EllicglysTiain ack Gamma  On/ ;;;gb URTHIEREES Y S
Il Matrix On/Off UZPR NI OIRBRUOI—H—
H < N O ABIERRER RS/
ﬁ!ﬂ 9%
i Knee On/Off TR A Y T T D
t White Clip On/Off ROA NT U THIEREEZA >
%‘ SATID
g Detail On/Off T4 T—IVRIEREEEA Y AT
#t EES)
Aperture On/Off PIN—F v —HIERBEZEA > 7
J9%
Flare On/Off TUPHIEREEZS Y AT7T 5
Test Saw On/Off TAMESEA Y/ FTID
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PAINT

1HH e =R As
White Color Temp 1500K~3200K~ XEU— AICFRESNERDA ~
BREARTELC. FF <A> 50000K (AIZEHIEE N\SUADBEEZRRTD

TIRDA bINSVXHE

%)

ZTVER T,

Color Temp —99~+0~+99 XEU— AICRESNCRTA &
BAL <A> INSUADTAME RTA. B
TAEE) ZERET D
R Gain <A> —99~£0~+99 AEU— AICRESNCRD A b
NSV RADRT A MEZRTETS D
B Gain <A> —99~+0~+99 AEU—AICRESNRDA &
NSV RADBYT A /MEZRTETS D
Color Temp 1500K~3200K~ AEY—BILREFEINERDA
<B> 50000K (AIZ#EIFE /I\SVRADBEBEZRNRI D
)
Color Temp —99~+0~+99 XEY—BIREFESNCRD A
BAL <B> NSVADTAE BRTAV. G
TAEE) ZEREIT D
R Gain <B> —99~+0~+99 AEYU—BICRESNCRDA
NSV RADRT A MEZRTETS D
B Gain <B> —99~+0~+99 AEYU—BICRESNCRDA &
NSV RADBY A MEZRTETD D
Black Master Black ~ —99~+0~+99 RRAI—=TSwIUNVERET
A AV (7‘5%{? %)
feo CLEW EEDE R Black —99—+0~+ = NI
BRI BRELFT, oo 9920499 RIZyIUVERETS
IS wH LN R, BBlack —99~+0~+99 BISwILNIVERET D
T. EZEHED. EZ
LD EVNDTERRIED D
AgET Y,
Flare ] Flare On/Off JUTBIEREEES Y /4T D
JU7BECBIT ST Master Flare  —99~+0~+99 RAT—TUFBELNIVERTE
’Eﬁb\i_g"oﬁ o I3
S mowEeS e R ~99~£0~+99 ROL7BELNLERET &
BD l//\“)lzé%?i\bfv G Flare —99~+0~+99 GI7U7RIELNIVZERTES D
CLEL. BRVEDDH e —99~+0~+99 BIL7BELNILERET D

BLIFBDRRT, LUX
PIER T DIEDELRET T K
DRELET,

ME_TZK =9
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PAINT

I5H HE EIRE RE

Gamma i Gamma On/Off VARG N 2 P RIS

PYXBLICMISEE Sep Gamma  035~045~0.00 (0.05 71 YMIEBZ0.0645 ¥ J Tl
T . A

HURMIEICKD, BEE

ATwv)

EID

DAYV FSANEHAEL

T, BBOMRZEREL

BRBHTEDTEFXT,

Master Gamma —99~+0~+99 RRAI—HBIRUNIZHRET D

R Gamma —99~=%0~+99 RAVRUNIVZERET D

G Gamma —99~=%0~+99 GAHYN NIV ZERET D

B Gamma —99~+0~+99 BAVNUNIVZERET D

Gamma Select Gamma CategoryDi&EIR HYVHIEICERATHYIT—
[C&DZEDD ([AE]  JILERRT D

W)

Gamma Categoryh'STDDIHS

1DVW : DVWAH AO—5—18H

2 X4,5: X455 4>

3 X3.5: X355 104

4 240M : SMPTE-240MAEX4

5 R7())9 D ITU-R709t8 (¥1HA5%
E

6 X5.0: X5.05° 1>

Gamma Category ' HGDIS &

13250 : 325%DETFH A%
100%DE T A HAICERT B

24600 : 460%DETFF AN%
100%DE T A HAICERT B

33259 : 325%DE T AN%E
109%DE T A HAICERT B

44609 : 460%DETH A%
109%DE FAHAICERT B
(WIHARE)

Gamma STD/HG R VEF—RHAUT (STD) &\
Category AI)—HUY (HG) DEBS%EE
AT5MERT S
Black Gamma Black Gamma On/Off ;5;7 ANAE N v
o TSwIHURMIEICE 795
ot gg%@%@gfﬁ%_g Gamma Level —99~20~+99 RRT=TSvIHIRUNIE
% D BBOBRFFRLC __ HEYS _
I FELY (BELY) ZyoResg  hange Low/L.Mid/H.Mid/High 25y OAYIHBIEDBENEHEE
H  pagLhBRTdIs BEIRT S
| HTeEET, LOW : 0~3.6 %
it L.MID : 0~7.2 %
i H.MID : 0~14.4 %
r HIGH : 0~28.8 %
':% Knee i Knee On/Off ——HERREESY A TT B
g %a?%ﬂcﬁ%ﬁﬁﬁ@% Knee Point  50.0%~90.0%~109.0% ——A > NERET D
A maoms KneeSope  —99~+0~+99 ——RO0—JEREIB
VBB Z5eER 119D  Knee On/Off Z—HFal—TavEEEEA Y
BRIGDS A F=w oL Saturation JSATITD
IO LRI CTERL. — — —
B BEE <IHE T ggteueraﬁon 99~+0~+99 %gg}l =3\
Z—EDBEDDESL oyl

Nz [Z—=R1> b,
IS KD ERDEBEE
[Z—XO-7] &FUR

o
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PAINT

I5H #HE IR ARE
White Clip White Clip On/Off ROA oUW TiRKEEE A >
ROA ~oUw THRHE(C SFTITB
IR EZITVET.  Tevel o~ % I L EBEE
ROA RS v T, eve 90.0%~109.0% /%)T\'j/f oUW TUNIVZRET
TAHIMESDERALN
JVICHIBRZ DT NI T
I, ETHENES DR
KfigZz [IRDA ko Uy
TNV EFUFRT,
Detail(HD Mode)/ Detall On/Off T4 T—)ViABKRE A AT
Detail(SD Mode) EXS)
HDE—RIFE/ESD  Tevel —00—+0— == YL, EDE
e B T —)LH eve . 99~+0~+99 TjTinA%%ﬂ%?é
®(CEd R ERTLE H/V Ratio —99~=+0~+99 HF 4 T—JLLNILEVT T =)
7, LNIVDZ Y IR ZRET
24;E%§%H\H5 Crispening —99~+0~+99 TGURTZVITUNIEHRET B
) Fﬂi? o [C?’f T— ST o~ 1o P <
VES RN CHeES Level Depend  On/Off ngggﬁ/hﬂﬁﬁﬁ%j/
AU, U TG EE S —
MY 2ETT, teve: Depend —99~+0~+99 LANILF A Ry RUNVERET
eve %)
Frequency —99~+0~+99 H7 ¢ T —)LIESOP0ERSZR
FTID (BEAELIBEFET 1
T—IVIFH<ED)
Knee Aperture  On/Off Z—7I\—F v —HIEREEE A
SFTTB
Knee Aperture  —99~+0~+99 TP N=Fr—UNIVERET
Level )
Limit —99~+0~+99 Bl BEA@HE[a0T «T—/)LU
SYY—ZREITD
White Limit —99~+0~+99 BRIDT 1« T—ILUZ v 5 —7%ZH
9D
Black Limit —99~%0~+99 BRIDOT « T—ILUZ v —%ZR
ECIS)
V-BLK Limit  —99~10~+99 RRDVT « T—ILUZ v —%&H
ECIS)
V Detalil NAM/G/R+G/Y VT 4 T—)VESZER T DIcHD
Creation V—AESEERT B
NAM : REESHSESNVT «
TIUESLGIESHSESN
eNT 4 T—IUES EBESD S
EONVT 4 T—ILESDD 5
RHLNILDOEWVES
G:GES
G+R:GIESLRESZ1 I 1TA
B UKES
Y YES
Aperture Aperture On/Off TPIN—F v—IEREEZEA > 7
7§:?ﬁ—ﬁ£[%§ 79%
OREEATNET, Level —99~+0~+99 P —F v —UNLERET D

PN=Fv—HEF. £
TAESIC. BEABHD
TI=F v —ES5ZEMA
TREBBEIEIC KL DHIE
ZRIEL. BREZSH
DIETT,

XZa1—8

WE-TZX =9
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PAINT

1HH e =R As
Skin Detail Skin Detail On/Off AF VT4 T—)UEIEREZES >
AF2 T 4T —)UFEIEIC SATID
I SREZTVEI.  Area Detect & E-E T . #
STy S, AreaDetection igHiEE %g%éégé)bﬁmmﬁ%t S
Dl ZEENWVCEE —
giﬁ&%ﬁﬁ’\]?\ PR Area Indication On/Off 22X T 4 T—)UHIEDTR ETR
& (i) OEEEREA 2EODIVU7ICEISZERRTD
TF 4TINS Wpees> 4795
WS EDUIETT, Level —99~+0~+99 AF VT4 T=)VINIVERET
%)
Saturation —99~£0~+99 AFUFA4T—)UHEDRREE
LHBOEME (WFalb—3Y)
ERET D
Hue 0~359 AFUTA4T—)UHEEDOHREE
B0 (1—) BREITD
Width 0~40~90 AFVTA4T—IUHIEDWREIL
SEOEHDEEZRED D
Matrix Matrix On/Off N NUOREIEEREE A AT
X NUOAFHIEICET D EXS)
REZETVET Preset Matri On/Off Jtw I 27 A
CRUSRRERCED, oo Mk on J Ly bR ARREES Y
RIEDBE. #PHhSz =
g5 hcEEg, CresetSelect  1/2/3/4/5/6 TJUtw Y RNJITAZEIRT D
[Tty hY U2 11 SMPTE-240MAE
ELTHSN UHARS 2 1 |ITU-7094824
NS A—S—1w ~ 3: SI\/IF"I:E/ WIDEARZ
MHEMICESY NI 4:SDHRH
2ERRUEO, [1— 5: EBUIE
F—YhUS2R] £LT 6 - Standard
BN TINOA—5—%5% User Matrix On/Off I—Y—< NU T RFHEIEMEEE S
EITDHENTEFET, V/ATTD
User Matrix R-  —99~+0~+99 R-GO1—Y—< MU I RZEFERIC
G BETD
User Matrix R-B —99~+0~+99 R-BO1—H—< U IR ZERIC
BETD
User Matrix G- —99~%0~+99 G-ROA—T—T MU IR EFEEIC
R BEITD
User Matrix G- —99~=+0~+99 G-BDA—T—T IR EFEEIC
B BETD
User Matrix B-R —99~+0~+99 B-ROI——<Y U I RXZHERIC
BETD
User Matrix B-  —99~+0~+99 B-GO1—Y—< MU I RZEFEREIC
G BETD
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158 e BEIRE nE
Multi Matrix Multi Matrix On/Off TIVFT MU O IEHgEZ A >
g)bﬂ'- F%QX?%(CE@ SATITB
SREZTVET.  “Area Indication On/Off RIVFX MO ZRBEDHREL
NIVFY U TAMIE. é@@zu7mﬁ@5@§§35
1§§Q§ﬁ<HW>%ﬁ RS A TTD
TEIFE (Saturati .
miE 23, " Color Detection GRHBIE LT T AREDHRETS
LHEERET D
AXis B/B+/MG—/MG/MG+/ <ILFT NI ZBEDTRES
RIR+/YL=/YLNL+/G—/ 28 (1681E—K) ZHREI D
G/G+/CY/CY+/B—
Hue —99~+0~+99 NILFY MU I RABEDHR S
0l (E1—) Z168E—
RCEICHRET D
Saturation —99~£0~+99 RIVFY MU T ZFHEEDRR E
LEOEME (UFalb—y3Y)
Z1I6HE— RCEICRETD
V Modulation V Modulation — On/Off VEValb—yavyvrz—F42Y
VEYa l/-“/ﬁz;ﬁ‘/ - WIEHREZA >/ F 79D
I T4 TWIEICE Master V —99~+0~+99 YAF—VEYIL—Y3 VLA
FOREZITVET.  Modulation BERETD
U ETYUXLDEER - — = < <
TRETHEEAGOR RV Modulaton —99~+0~+99 R1_§i@VE‘/1 L—3N)b
EDEXZEBELFT. BETS
G V Modulation —99~=+0~+99 GESOVEYaL—arvinNIb
ZRET B
B V Modulation —99~+0~+99 BESDVEYaL—3a NI
ZRET D
Low Key Sat. Low Key On/Off O—F—UFal— 3 HIER
O—*—YF2l—>3 Saturation BEEL >/ ATID
VHIEICRT OREZTT Level —99~£0~+99 EEETU7DROBRNE (B
ReORL B DEDR Fal—Y3Y) #RET S
SRR ECEET, Range Low/LMid/HMidHigh O—F—JF 1L —> 3 @ik
BT DEELANILZRIRT D
MAINTENANCEXZ=1—
AFCRRSNTVDHREMEF. HEROIMHREECTT.
158 #HE BEIRE RS

White Shading
ROA MY T—F VY

Channel Select

Red/Green/Blue

MIA Y T—7 1 VIBIEDNR
EERT D

FHIE(CRIT DREZTTL) R/G/BWhite H —99~+0~+99 KFEARBDSAWRT A b T —
igi( S Saw T4 VI EZRET D
e RIG/B White H—9g~£0~+99 KEBADI SRS RIA R T—
3L XDt kDR Pl N arinarss
f?éﬁﬂé@ﬂﬁﬁ@@g RIG/B White V. —99~+0~ 199 BEESADSAWT A R T—
SPBLST, VX Saw = 5 Zrio

LopeLaT L 74 MEEERET D

R/G/B White V. —99~+0~+99 FEEHOOD/(SRSKIA b T—

Para T4 VIHIEEZRET D

White Saw/  ORJOR ROA RS T—5 1 Y IDSAW,

Para INSRSHIEREEEA>Y /FTI2

XZa1—8

WE-TZX =9
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MAINTENANCE

I5H #HE IR AE
Battery Info Before End 5%/10%/15%...95%/ N T U—) 0y I BP-GLOSATE AR
NNy FU—[CRETDRE 100% [T TBattery Near End] #&XR9I D
ZTVER T, UEVVBEZRTET D
Info End 0%/1%/2%/3%/4%/5% )\ F1J—)Cw & BP-GLISAE S
IC [Battery End] Z&Rmd LT
WVMBZERET B
Sony Before  11.5V~17V (0.1VR JCy 5 U—)Cw 7 BP-L60S/L80SHE
End Fwv ) FABS(C [Battery Near End] =&k
THUEVEZERET D
Sony End 11.0v~115V (0.1VvR )V FU—)Cw o BP-L60S/L80SE
Fv ) FABS(C [Battery End] &R I D
UEVVBZERET D
Other Before  11.5V~11.8V~17.0v  VZ—&DAD/\y FU—/)Cy I fE
End (0 AVRFTwvD) FABS(C [Battery Near End| Z#&KiR
THULEVEZRET D
Other End 11.0V~14.0V (0.1VZ VZ—EYHD/\yFU—/Cy I{&E
Fv ) FABS(C [Battery End] &R I D
UEVVEZRTET D
DC InBefore  115V~11.8V~17.0V  DC INIisF(CHABERZZERFELTL
End 0. IVAFT v ) 2BEI(C [Battery Near End] &
MIDULEVEZRET D
DCInEnd 11.0V~14.0V (0.1VZ DC INsmFICHEBRZEE R U TL)
Twv) 2B AIC [Battery End| Z&RmRY
HUEWMEZRTET D
Detected Info/Sony/Other/DC IN  )\w U —DfEfEaxBEHRI Uicig
Battery RERTI D
Type Detection Auto/Other Auto : /\w T U—DiEEx B
GlERs)
Other : J\w T U—DfEfE=
[Other] ICEELTHFITS
Segment No.10 11.0V~17.0V (0.1VZ  [Other] #IER. \wFU—%XE
Twv) Fn (BR—IUBHR) DEXET
SegmentNo.9 11.0V~16.0V~17.0v  Z X~ hOVEITDEED LELME
(0.1VAT v ) ZEREIT D (REUIERECTHL
SegmentNo.8  11.0V~15.0V~17.0V 9%)
(0AVRT v )
SegmentNo.7  11.0V~14.0V~17.0V
0AVRTv)
SegmentNo.6 11.0V~13.5V~17.0V
(0AVRT v )
SegmentNo.5 11.0V~13.0V~17.0V
(0AVRT v )
SegmentNo.4  11.0V~12.5V~17.0V
0AVRTv)
SegmentNo.3 11.0V~12.0V~17.0V
(0AVRT v )
SegmentNo.2  11.0V~11.5V~17.0V
(0AVRT v )
Segment No.1  11.0V~17.0V (0.1VX
Fv)
AZa1—8



MAINTENANCE

I5H #HE IR AE

Audio Front MIC Mono/Stereo JOVKNAOEE/S)U
F—T 1« FICRETDRE Select (Mono) [C9dh. AT L7
ZTWVWET, (Stereo) [CTHHEEIRT D

Audio CH3/4  Ch1/2 / Switch
Mode

AUDIO IN CH3/CH4imFDASE

SEERTD

Ch1/2 : AUDIO IN CH1/ CH2iF
ERUES

Switch : AUDIO IN CH3/CH4 R
A vF CTERSNCANES

Front MIC CH1 —70dB/—60dB/—50dB/

JOYMRAIDF v/ R)JVIDE

Ref —40dB/—30dB/—20dB #EAFLNLZZERT D

Front MIC CH2 —70dB/—60dB/—50dB/ 70> hX A JDF + % IL2DE
Ref —40dB/—30dB/—20dB #EANUANILZEIRT D

Rear MIC CH1  —70dB/—60dB/—50dB/ AUDIO IN CH1ZA v FDHREN

Ref —40dB/—30dB/—20dB

glc@ii'z@@%ﬁ)\jj LAN)V7E IR
B

Rear MIC CH2 —70dB/—60dB/—50dB/
Ref —40dB/—30dB/—20dB

AUDIO IN CH2Z A v FDREN
MICDIZEDEEALANL7ZER
ER)

Line Input Ref  +4dB/0dB/—3dB/EBUL

AUDIO IN CH1/CH2ZA v F D&
EDLINEDBEDEEANLAIL
EEIRTD

Min Alarm Off/Set ALARMDFEHZERD Eofc&EED
Volume SEXEIRT D

off : (FIFET AL

Set : HHIEEFBZD
Speaker Off/3dB/6dB/9dB/12dB F=4—AF—H—h'SDZHERE
Attenuate RIS (A VRVOBEICIFEEL

L))

Headphone Mono/Stereo

AVYR>VEE/ )L (Mono) (T

Out 2. AT LA (Stereo) (CTDH
ZEIRT B

Reference —20dB/—18dB/—16dB/ 1kHzT7 X MEBSDHALNILZER

Level —12dB/EBUL 9D

Reference Out  0dB/+4dB/—3dB/EBUL

BEASUANIVICHT DALV
ERET D

CH1&2 AGC  Mono/Stereo
Mode

Frvrx)U1, 2[CEERT SO
IHA—TFT A FEBESDAHLNILDE
A, FF v URIVTHILLT
71510 (Mono). AT UAE—NR
T115D (Stereo) ZEIRT D

CH3&4 AGC  Mono/Stereo
Mode

Fv )3, 4lCEERT SO
IHA—T A FESDAFIUNILDE
A, FF v URIVTHILLT
15h (Mono). AT UAE—R
TITSh (Stereo) &=EIRT D

AGC Spec —6dB/—9dB/—12dB/
—15dB/—17dB

AGCOD%siE (BaAILAIL) &R
EEG)

Limiter Mode  Off/—6dB/—9dB/
—12dB/—15dB/—17dB

F—7 4 ZAHUNIVDF R
B, REBLADESICHTDHUZ Y
&4 (BN LNV EERT D
U= w5 —ZEAUBEWEEFOff
EERTD

Output Limiter  On/Off

T—TAARNI=ZvI—"=AY
F79%

CH1 Wind Filter On/Off

F v VRV OREERR T LT —

"X/ FTITD

CH2 Wind Filter On/Off F v RIV2DORBER T «ILT—
TAY/FTITD

XZa1—8
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MAINTENANCE

[Z] =] EIRE AE

Audio CH3 Wind Filter On/Off FvRI)VIDRABIERT 1 IL5T—

F—F 4 FICETBRE BAY/ATID

ETVET, CH4 Wind Filter On/Off F o URIVADABER I LT —
BEEVFTTB

Audio SG On/Off/Auto
(1KHz)

NS —)\—F— FEICIkHzDT R

MESZHITDD (On) HFHL

BFLn (Off) Z/ET D

Auto : AUDIO SELECT CH1R A v
FOHRENAUTODIZEDHT X
MESZELHTD

MIC CHT Level Side1/Front/
Front+Side1

J0Y MNAODANBEZEF v/
KIV1ICEERT DHBAIC. EDDFR
HTEEUNIERET DH7ZREIR

)

Side1 : Y R/{RJLDLEVELDH
& (k)

Front : 70O ~{XJLDMIC
LEVELDZEH

Front+Side1 : LEVELDZF# (k)
EMIC LEVELDE A EETED

MIC CH2 Level Side2/Front/
Front+Side2

JOYMAODANEEEF v/

X)L2|CEEx T BHmAIC. EDDFR

%g?%f-% UNIVZERETT D h 7EEIR
3

Side2 : U R/{RJLDLEVELDZ
& ()

Front : 70O ~{XXJLDMIC
LEVELD & H

Front+Side2 : LEVELDZEH ()
EMIC LEVELDE A EEHTED

Rear1/WRR Side1/Front/
Level Front+Side1

DA VLA AZEUTIRRILD

AUDIO IN CH1S%FICH it Ui feas

EEDDEHCHRE LNV ZRBET

DHZERT D

Side1 : U R/CRJLDLEVELDZ
& (k)

Front : 7O/ ~/\JLOMIC
LEVELD &

Front+Side1 : LEVELDZEd ()
EMIC LEVELDE A EETED

Rear2/WRR Side2/Front/
Level Front+Side2

DAVUVARA D EUT7)RILD

AUDIO IN CH2timF i U Te #Es

EEDDEHCHRE LNV ZRBET

DHZERT D

Side2 : Y R/{RJUDLEVELDH
& ()

Front : 70O ~{XJLDMIC
LEVELDZEH

Front+Side2 : LEVELDEd (£)
EMIC LEVELDEH A EETHED

Audio CH3 Side3/Front/
Level Front+Side3

F v XUBICEESINSER LA
72 EODF B CTHRETT DH7EER

EX)
Side3 : U F/(RJLDLEVELDR
o

Front : 7O/ ~/{RJLMDMIC
LEVELD&EH

Front+Side3 : LEVELDEHEMIC
LEVELDFHZEEII D

XZa1—8



MAINTENANCE

I5H #HE IR AE
Audio Audio CH4 Side4/Front/Front+Side4 F+ >R JVAICERBINDZE LN
F—FT 4 FICEETDRE Level WZEEDDEHTRET DN ZEER

ZTVE T,

EES)
Sided : U K)\RJUDLEVELDR
&

Front : 7O ~/URJLDMIC
LEVELDEH

Front+Side4 : LEVELDEHEMIC
LEVELDFHZEEIIED

WRR Setting
DA VUAFa1—F—IC
HIREZTVET,

WRR Valid CH All/CH1
Sel

DAVUALY—)\—DF + %)l
1. 2&BERICTDD (AN, Fv
VRIIDHFEEMCTHH

(CH1) Z&EIRT B

WRR CH Select TX1/TX2

ANBZAZ1—(CRRITDREF v
DRI EEIRT D
X1 F v VRIVIDORBZERRT

)
'm%:ivyzﬂewmg&ﬁﬁﬁ

DAV U AN IEEDEILfHIEKAE
ZEMCT DN (On) FMCTD
h (Off) Z&EIRTSD (OnZERT
BEINTCDE-ELNDEEDHY
8msIELET D)

WRR CH SELECTCEIRUfeTF v+
RILTRIEL TV DX SRR Z
KTRID

WRR CH SELECTCEIRUfcTF v/
FIVTRELUTVDEEEDAFL
NI E—=oF—I\—hEShZEx
)

WRR Delay On/Off
Comp

X

TX Audio Peak ---/Peak

TX Input Level ---/Mic/Line

WRR CH SELECT IR Ufe F + >/
FIVTRELTVHEERDATIL
NIRA4Z (Mic) £54>
(Line) DEBBICERESNTND
hZERTI D

TX ATT Level -

WRR CH SELECTCEIRUfeTF v+
FIVTREUTVDEEEDATTL
NIVERTE T B (REMBDAZEH
[F. BEUCVOXEKICIOTE
FBHBEDHD)

TXLCFFreq -

WRR CH SELECTCEIRUfeF v+
RIVTRIEL TV X EHOO—
Ny ST —FERBZERET D
GEEOTZEHAE. ZELTV
%i)i%%ﬁlid:??igéf%‘%b‘ﬁ

TX System
Delay

Auto/0.0ms~8.0ms

BSEDELEZHRTET D

Auto : JA VUL Y—/\—H'5B
EONTL DEEDIELEEN0(C
BBHKDICHEMNICELESZH
E92

0.0ms~8.0ms : 7 —F (A =F
Y- EZN L TEHDD AV
VAV Z LZERLTVWDIEE
[T, PRAIIND DA VUATR
T LADEEEZRTET D
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WE-TZX =9

ATEME

135



MRE_T "X =9

M

136

IHE #HE

EIRE

AE

Timecode TC Out
YA LD—NICET DR
EZITVERT,

Auto/Generator

A LD— NEHFZEERT 5

Auto : ECEREFIFY A LTO—RI T
KU—5—DEZHAIL. BE
B LO0—RU—5—0D{E
ZHIITD

Generator : 5CixE, BERCDHY
ALTD—RITRU—5—DIE
ZHITD

DF/NDF

DF/NDF

CountryDsRENPAL Areal IS DIZ
A, ROV ITU—LE—R
(DF) FfelF /> rOvITU—LA
F—R (NDF) #&ERID

LTC UBIT

Fix/Time

LTCOI—Y—Ew MIE#HRT D

TF—IEREIT D

Fix : I—Y—DRELCT—5 %=
B I)

Time : REDKZZCEI D

Counter
Display

Counter/Duration

Ea1—J7 A2V —[CRRSNDH

g%@—@@uv\/ ~DFEEZERER

Counter : RESET/RY V7Z#HT &
THEEINS

Duration : ECiRBESAC E(CU Y
~ENd

Essence Mark
Y3y hN—UETLR T

Ret Shot Mark  On/Off

U XDRETNS 2 7% %A U T Shot
Mark1Z A1 20 E S DERET

A JLDRKBICEIT D% 2o
EZTVET, Ret Shot Mark  On/Off > XDRETRS > %Z{EFH L CShot
2 Mark2ZZ AJ9 o\ EDHVERTET
Bo
XZa1—8



MAINTENANCE

=[] b= ] EIRE AE
Camera Config Rec Tally Blink  On/Off Ny TFU—KEBROXT 1 FRE
HLO—5—DEIESE POFNTHEfcEETDY U—UH
[CRT R EZITVER T, EE /A TTD
Rec Review 3sec/10sec/Clip LwoUE1—BREZEIRT D
Clip : BAIICEER U U T24%
ZlwyolbbEa1—d93
HD SDI Off/Chara/G-Tally/R- HD/SD SDI OUTsFICIE R 1z
Remote I/F Tally SIEBHE SR O T D ECIREN I BE
ZERT HHE DN EEE L(HDSDI
H85). EATDBEFHNEMEER
DECEIREE T H D T EDRRFEE
BRI D
Offb: SCERED{ERIEMEREZ(EMA LIS
\
Chara: Ea1—J7A V4 —EELE
DA B ERHIHRR CRRT
G-Tally : E1—TJ7 A V45 —EHE
DIV —20HU—-THRRT D
R-Tally : Ea—7 7 A 25 —@EmE
L DFEHFE— R EEIREERT
TRNID
Color Bars ARIB/100%/75%/SMPTE 15— )\—DiEE=EIRT D
Select
RM Common  On/Off UE— IV bO—)LAZ Y MMER
Memory FFEO—NIVIRMER CREZHE T
5h (On) EBELELD (Off) 7Z
BRI D
RM Rec Start  RM/CAM/PARA UE— IV bO—)LAZ Y MMER
FFCEB S MEEERRR,/FIERY >
ZBWICT DN ZERET D
RM: UE—hrIJ>bO—)LOZ v
~
CAM : hLAO—4—
PARA : @/
Image Invert  On/Off BRD ENRISHKREZES Y AT T
)
Rec Start/Stop  On/Off SCERBRIR/REIEROEES =4 /A4
Beep 793
FVDEE, FECERBEAEIC 1Bl 5
RIFIERFC2EIE —TEDIED,
Rec Status On/Off SRR E RS A VI —Y—%&
Indicator Ea—J7A V9 —CKRRITDHE
SNEZVIATT D
Preset White Color 1500K~3200K~ RIOA NSO TUTY MEZE
ROA NSV ZAD T Temp<P> 50000K (FIZ#HEIFEH H/EITD
ty MBEICEY dRER z)
TLET, Color Temp —99~+0~+99 Color Temp<P>CTHZEDIRIEHE
Balance<P> SN DIEHBEIC. IHICHN<
BREZHRETD
R Gain <P> —99~+0~+99 RTIAVDTUEY MEZRET D
B Gain <P> —99~+0~+99 BTADTULY MEZRET D
AWB Enable On/Off WHITE BALAA v FHPRSTD &
<P> T.AWB (F— RO A NSV

%\) EFRITT DR A TT

MZF_T-K =9

ATEME
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MAINTENANCE

I5H #HE IR AE
White Filter ND Filter On/Off BRMCCT 4 )LY—%2ZNDT 1)L
T4 )L5—(CBT BERE C.Temp SF—(CEIDHTDWEE=EA Y AT
ZTWVWET, EX)
ND FLT 3200K/4300K/5600K/ BRMCCT 4 )LF—%2ZNDT « )L
C.Temp<1>  6300K F—CEIDHTHEETDEEEZE
RITD
ND FLT 3200K/4300K/5600K/ BXWCCT 1 I)LZ—=ZNDT « )L
C.Temp<2-4> 6300K F—(CEIDHTHETDEREZE
RID
Electrical 3200K/4300K/5600K/ BRMNCCT 4 )LY—DY) DR %
CC<A> 6300K BEZE 7 TAFT TIVRA wFICEIDH
THEETDEREZERT D
Electrical 3200K/4300K/5600K/ BRMNCCT 4 )LY—DY) DR #E
CC<B> 6300K BEE 7 AT IIVRAA wFICEIDY
THEETDEREZERT D
Electrical 3200K/4300K/5600K/  EHICCT « )LY —DY) D8RR
CC<C> 6300K/----- BEZ 7 TAFTTIVRA wFICEIDH
CHEEDEREZEIRT D
CZEEDENEEF----ZEIRT D
Electrical 3200K/4300K/5600K/  EBRHICCT « )LY —DY)DEZ #
CC<D> 6300K/----- BEZ 7 TAFTTIVRA wFICEIDH
CHEEDEREZEIRT
DZEBEOLEVNEEF---ZRIRT D
Auto Iris2 Iris Window 1/2/3/4/5/6/NVar FT—RPAURBED 1> RODFE
FT—hPAURICEETD WEERT D
BEZITVET, Var @ O/Z&
Iris Window Ind On/Off FT— TP AURBHD 4> ROD#:
EN—N—CRNI DtkpezA >/
793
Iris Level —99~+0~+99 d— 7 AUZXDBEZEDUANILZE
BEITD
Iris APL Ratio  —99~£0~+99 F—h7 AU GREBEDE—IEE
FHBEDOI Y DAL ERETSD
(OPERATION >TLCS >Mode®3%
EH'StandardDIFEDHER)
Iris Var Width  40~500~999 Iris WindowDERE h\VarDBE 1k
HO4 Y RODIBEZRET
Iris Var Height  70~500~999 Iris WindowDEZEDVarDH&E (TR
HO1 Y RODESZHRET D
Iris Var H —249~0~+249 Iris WindowDERE HVarDIBE Tk
Position HD Y RODKFUBZREY D
Iris Var V —249~0~+249 Iris Window?¥ris WindowDE&EH
Position VarDZE(ICHERE D « > RODEB
IBZRET D
Iris Speed —99~+0~+99 FIEAE—~ (REOZLICHT S
RINEE) ZHRET D (EHAREL
[FERMFRLED)
Clip High Light On/Off SEEBORLZERLC. SIEE
(ST DRINZETL S DHkEEZE 4
/A TID
XZa1—8



MAINTENANCE

15 e BIRE As

Flicker Reduce Mode Auto/On/Off T w H— B DB E AR e g

1w D—FIEREEICRES o

FREEETVED, On : BICENMESHED

T E BRI HEE Auto : 7y H—ZRHET 5 EE)

HZIL T BEBETNTHE )

KR Uflc &, oo Off : EfES B

JLU—LLU—bhEDBER Frequency 60Hz/50Hz Ty A—DEREFE> TV DIRHA

TRETDHIUYH—7= DERREHICADED (THEHE

WECEEXT, BEDERTE(E. CountryDERENPAL
AreaDiIBE(E50Hz, PAL Arealdst
DB EIF60HZ)

Genlock HPhase(HD) —999~%0~+999 70w ZBEDOHDEHDHARZ

S VOvIICBETDRE BETD

ZTVNE T, HPhase(SD) —99~%0~+99 7> 0w ZREOSDEADHAEZ
BETD

Reference Internal/Genlock KAENER U TV EEEEDRESE

ZRNT D

ND Comp ND Offset On/Off ND 7 1 LY —DEFNFHIEHRE

NDZ « )LZ—D&E TN Adjust

EICEY 2R EZITVE Clear ND Execute/Cancel NDJ 4 LT —DBEIFNELEEE Y

EB Offset
AWEDND T « )L —(F

T4 —T&ICT<Db
FHEIELDCH. ND

T4 )L5—ZY)DIR 1o
EETINTA MG VR
NFENDTENDDEFETD,
TAI)F—CEDBODE
ZHHH UHFIEESE U
THRELTHE. B8

U779 % (ExecuteCTRITI D)

[CBTNEZMET DL

WTEFT,

Lens Auto FB Adjust Execute/Cancel el X TR UTDIHA— TS
d—hTSVII\y T VINY TRBEERTIT S
BEFRGTULET. (Execute CER{T9 d)

Trigger Mode i.LINK Trigger Internal/Both/External  ECiFBHtA,=IEDEREE. SxSXTE
SCERRE fF L hUH— Mode U—A—RICHLTDHTIBEEF
[CRAT HREZTVERT, Internal. i.LINK (HDV/DV) i+

HD/SD SDI OUTHHF(C #&i5 U fe i
BITH UL TOHMTSBAEIE
External. SxSXEU—H—R&EH
BRI O (CH U TIT OB
Both7Z:#IRT %

XZa1—8
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MAINTENANCE

I5H =] EIRE AE
Network Setting 2) DHCP Enable/Disable DHCPY—/\—h'5IP” KL R7%ZH
v NI — O ERICEY RS I HH (Enable) LIELID
DREZITVE T, (Disable) Z&EIRT 2
IP Address 0.0.0.0~ DHCPH'DisableDiz&E(C, IP7 K~
CER 255.255.255.255 VRAZRET D
* Wi-Fi7?9 75— CBK- (192.168.1.10)
. %@%%ﬁ%agg%m Subnet Mask  0,0.0.0~ DHCPDDisableDBAIC. T
“_9‘_(7[/_2%1__)7‘ 255.255.255.255 XY NYRIEHRETD
e Default 0.0.0.0~ DHCPA'DisableDiF&(c, 777
@ 2y ND—SIEREICD Gateway 255.?55.255.255 )I;}l;’]’— I\'j“I/ﬁZExE_Q"% -
WL, User Name admin ﬁ%@l—j:%%ﬁ&?%(%@
[Manuals for Solid- FTI~81XF) _
Password pmw-320 (#i&%) JIRDT— R (iER) ZREIT D

State Memory
Camcorder| MDCD-

(EHFTO~31XF)

ROMI(CUSREENT LD Set Execute/Cancel Network Setting T1T D e iR E 7z i
Supplement (77U EID _
XU K) mSBLRE (Execute C=1T)
Lo MAC Address MAC” RLURZEXTY D
Net Config Execute/Cancel v ND—UDRE=EDEREICRT
Reset (Execute CHEAT)
XZa2—8



MAINTENANCE

=]

e EIRE

AE

Wi-Fi Setting 2)
Wi-FilgiR(CRA T o8 ER

Scan Networks Execute/Cancel

Wi-FiD'EnableD & F=(C, Bt E
Bejigtd

TVET,

SSID xy hI—=0%

Ry hD—URZERETS (32X
FLR)

[ TR
Wi-Fi? 4 7% — CBK-
WAOIHAETT .,
iR, BERRINT
T (JL—Fmn.

Network Type Infra/Adhoc

ERt— REREIRY 5,
Infra: (2752 NSOFvE—

R
Adhoc : 7 Ry OE— R

@ Wi-FilEFICDWTEEL

Ch 1~11

Network Typeh'AdhocD & FE(C.
HIRT v RIVZEBRET D

<IE. [Manuals for
Solid-State Memory
Camcorder| (DCD-
ROMIZIERENTLD
Supplement (F7U
XU hK) ZCBLEE
Lo

Authentication Open/Shared/WPA/

WPA2

X ND—TREFEZERT D

Open : A —T7 Y RT IR

Shared : #5+—53

WPA : WPA (Wi-Fi Protected
Access) 535

WPA2 : WPA2 (Wi-Fi Protected
Access2) 3aE (Network Type
HinfraDIZEDH)

Encryption Disable/WEP/TKIP/AES

T—IZES{ETONEDINERES

{EARZEREIRT D

Disable : BES5{t LKLY

WEP : WEP (Wired Equivalent
Privacy) A CHES1E
(Authenticationh*Openz el
SharedDiZEDH)

TKIP : TKIP (Temporal Key
Integrity Protocol) 5T CHES1{t
(AuthenticationWPAZE fz (&
WPA2DIZEDI+)

AES : AES (Advanced Encripion
Standard) B CTHEESL
(Authentication®WPAZE fz (&
WPA2DIZEDI+)

WEP Key Index 1/2/3/4

Encryption"WEPDEEIC, F—
DAV T I RTERIRT B

=9

Input Select  Encryption S"WEPDIZ&
ASCII5.

ASCII13,

HEX10.

HEX26.

Encryption O TKIPE Tz (&
AESDBE

ASCII8-63.

HEX64

Xy hD—0F— (FlelFt+alU

T4 —F—) [TV TAFERZE

RID

ASCII5 : ASCIFER T5XF

ASCII13 : ASCIFER T13XF

HEX10 : 16 T10H7 (3IF)

HEX26 : 16 C26H1 (IF)

ASCII8-63 : ASCII8E v MMER T8
~63XF

HEX64 : 161X Coatt CIF)

=X

Mg T

Key

ATEME

X hI)—=0F— (FfeldtFxal
TA4—F—) ZREITD

Set

Wi-FimEnable® &= (2. Wi-Fi
Setting CiT D IEEREZBRMICT D
(Execute T51T)

Wi-Fi Status [ T 1 []]

Connecting

EFDEITHICF [Connecting]
ZZRM U, BEPIC R EZR
DYTRRI B

Wireless Mode 802.11b/802.11g/

802.11n

IEEEB02. 11 (DFAEZ R
EEG)

Wi-Fi Enable/Disable

Wi-Fisin 2820 (C T &N ERNCT
BHEERTD
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MAINTENANCE

I5H #HE IR AE
Clock Set Date/Time REDHRZRET S
NEBSSTZ8ELE T, 12H/24H 12H/24H BRI ORI E 1 285B&R xR
(12H) [CTBh 4B (24H)
[T DN EREIRT D
Date Mode YYMMDD/MMDDYY/ FHAHORRERZEIRT D
DDMMYY YYMMDD : £8H®DI|E
MMDDYY : BHEFDIE
DDMMYY : HEEDIE
Language Language English/Chinese Xy t—IRRSBERE
Xyt —IDER=EEH (English) [C9 2HHE:E
BERUET, (Chinese) [CTDN7ZEIRT D
Hours Meter Hours(Sys) BEEABEAERRID (Utv
TIY)UEEEHCEE T % ~a)
REZTVE T, Hours(Reset) BEERREZRRIS (U b
a])
Reset Execute/Cancel Hours(Reset)Z0lCUzw T 5
(Execute CE1T9 %)
Version Version EXC IOV ANPESIIIENE 3
D= 3 VRS TID (Vxxx)
KUN—=2 327w T% Version Up Execute/Cancel AEEN—I 37 v ITTD

RITULEI,

(Execute CE479 %)

| SRR
SGAEU—H— RBBATNTL
B EHRRTEF B A,

a)CBK-UPGO2:7& 0%

XZa1—8
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AFCTRRSNTVDREEF. HEROYMHREE T

FILE

15 e IR nE
All Display Mode Date&Time/Model FEPROHUBICRREIND Y
ALLT 7 A JUDEREICRS Name A bRy U RTHERT DIEEZE
TIAREZITVET . RTD
AllFile Load  Execute/Cancel ALLT 7 A )L7ZIFUH YT (Execute
TRITT D)
All File Save Execute/Cancel ALLT 7 A )L {R1ET D (Execute
TRITT D)
File ID gg%)b(:ﬁ?ﬁ%ﬁ?@%ﬁﬁ%ﬁ
All Preset Execute/Cancel IRTCOEREZTUL Y MEICR
9 (Execute CE{T9 D)
Store All Preset Execute/Cancel IRTOERICDVWTIREDRE
BzT7Uty MEELTRFT D
(Execute CE1T19 %)
Clear All Preset Execute/Cancel IRTOEEHDOTIULY MEZ Y
U7 9% (ExecuteCTEITI D)
3Sec Clr Preset On/Off MENU CANCEL/PRST/ESCAPE X

A v F7%ZCANCEL/PRSTI(C 370
HWULFlEFFRICTDEEBEHTE
[Tty MER T U ESNDH
BEEAY /FTID

Network Data  Off/On AT 7 A )VZFUH YT EFIC,
Zv hD—2(CEY DEREZFH
JATH (On). FrIHATELN
(Off) Z=FEIRT D

Scene ] Standard T7AINESHXIUT 7AILID .
227 A)IVOBRMEC T2 Standard TP ANEBBLVOT 7 A)LUID 1k
BT BREETNE T, PAVEEDNY
[mE] Standard T7AINESBRUT7A)VID “
04 Standard T7AINESBKUT 7LD Ll
05 Standard TP AIVESBROT 7 AIUID "l'
OStandard RAELTEE it
Display Mode Date&Time/Model REFPHFUOH URICERRESND Y Al
Name A I\/T\‘y DO AICKRT HIBEHEZERE o
RID &
Scene Recall  Execute/Cancel NEXAEU—D'5T 7 A )LD &
Mem H9 (ExecuteTEITT D) filt
Scene Store Execute/Cancel NBXEU—ICT7AILZRIFET
Mem % (ExecuteTERITI %)
Scene Recall  Execute/Cancel SXSAXEU—H—RhST7A)L%
SxS HUHY (Execute TRITI D)
Scene Store Execute/Cancel SXSAEU—H—RICT7A)LER
SxS 79% (ExecuteCTE{TI D)
File ID T 74 )VICRK16XFDRFIZ T
72
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FILE

15 e EIRE: nE
Reference Reference Execute/Cancel U727 > AIEEDREDIREZ
UIJPUYRI7A)LD  Store AEBAEI—DUTF7LVRT7
BIEICEAT DEREZITL AIUICRTFT D (Execute THRITT
FJ, 3)
Reference Execute/Cancel D7 UV RT7AI)NZEIUTT
Clear % (Execute CE{T9 d)
Reference Execute/Cancel SXSAXEU—H—RhST7A)L7%
Load SxS HOHY (Execute TRITT D)
Reference Execute/Cancel SXSAEU—A—RICT7A)LZR
Save SxS 7929 (ExecuteTEITT D)
File ID gg4wmﬁka?®%m%ﬁ
Scene White  On/Off Scene >Scene Recall&Ffz(3Scene
Data >StandardDZE(THR. T A ~\S
VADT = EZFHFHACHE DD
BRI D
Lens Display Mode Date&Time/Model FREPHEOEUBICRRSINDY
UYZXRZT7 A )LDIRtE Name A MRy I X(TKRRT HIEE =R
[CRT 2R EZITVE T, RTD
Lens Recall Execute/Cancel HREATEU—H5 T 7 A I)LEED
Mem H9 (Execute CEITI %)
Lens Store Execute/Cancel WNEXEU—ICT7AIZRET
Mem % (Execute CE{T9d)
Lens Recall Execute/Cancel SXSAXEU—H—RhST7A)L7%
SxS HOHY (Execute TRITT D)
Lens Store SxS Execute/Cancel SXSAXEU—H—RICT7A)LER
792 (ExecuteCTHRITTD)
File ID REBICFUOHULIET 7 AIVICRK
16X FDERIZ T D
o Source EBRUCWVWD T 7 ILDESHE
e REND
Lens No Offset Execute/Cancel T7A)\&01)7d%5 (ExecuteT
% EIT9 D)
L' Lens Auto Off/On/Serial Number </ 77 ) LiBiExt i L > XEEE0E (.
| Recall FZEITDL VXTI 7 AL EEEN
o [CIFUHINE DN ZRET D
i Off : COREEEER LML
On : #BR(ICHMT OV XT7
) AIWZEHOHL, ZOREZR
=] g S
g Serial Number : > U7 )LESD&E
i ENERERL Y XDBEIF. #

BV UTIIESICHIET D
VX T7AI)IERUOH L. Z
DHNBZERIRT D, VU7 IVE
SDBENTELEVNL Y XDIH
Bl BERICHINTDLYX
T7A)EFUHT (OnllEE
Lic&EERL)
Serial Number EEINEVU 7 IILBENRL Y
DI UTIF VIN—DFRREIN
2 (HRL >V ZXDH)

Lens ID a7 ILBERmL >
ADEFERNFRREIND HInlL
2 XDFH)
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FILE

15 e EIRE: nE
Lens L Manufacturer EEINEVU 7 ILBENRL >
UV XA T 7 A JUDIRIE ADA—N—BRERREIND
[CRET 2R EZITVE T, L XD+
MV Modulation —99~+0~+99 LY ZX T 7 A )VICEEABDSAW
VI—T 4 VIHIEEZERET D
Lens Center H —40~0~40 VYA T7AIICEY - —
N—DKFIBEZHRET D
Lens Center V. —40~0~40 LYXT7AIICEY - —
N—DEEMNEZHRET ®
Lens RFlare =~ —99~#+0~+99 LY XT7A)VICRT L7 LN L%
BRETD
Lens G Flare ~ —99~+0~+99 VX T7AICGTLUT7 LX)V Z
BRETD
Lens B Flare  —99~+0~+99 LU ZXT7AICBT L7 LN L7
BRETD
Lens W-R —99~+0~+99 U ZXT7A)VICRIRD A MNS Y
Offset AMIEBZHRET D
Lens W-B —99~+0~+99 UYZXT7A)VICBRD A MNSY
Offset AMIEBZRET D
Shading Ch Sel Red/Green/Blue ROA N T—F« 2V TRIEDR
RERERT D,
LR/G/BH Saw —99~+0~+99 L X T 7 A JVICSKEHBDSAW
NOA b —F ¢V IHIEEE
BRETD
L R/G/B H Para —99~+0~+99 LRI 7 A )ITKFEREDIS
MIRDA b 1—F ¢ VIHEIE
BZHET D
LR/G/BV Saw —99~+0~+99 LY T 7 A )VICEEABDSAW
ROA N TI—F 9V JRIEER
BRETD »
L R/G/BV Para —99~+0~+99 LRI 7A)ICEEBREOD/S ok
RIKDA by 1 -5« VIRIE
BZHRET D IX
|
|
b
Al
_l}l’lg
=]
&S
filt
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PYLFTIVAA Y FICHEEZEIDIHTS

OPERATIONX Z 1 —(MAssignable SWT. ASSIGN. 0~3Z- w3 . ASSIGNABLE 4/5X1 v
FECOLOR TEMPIRY Y UV XDRETIRY U ICHARDHBEZEID B TH T ENTERT,
TIBHERICIE. ZNZNTIRICRIEEDENOZTENTVET,

2L VF /R Rege Assignable SW D:&E
ASSIGN. 01 v F REETE Off

ASSIGN. 121 v F OPERATION >TLCSDEEICEDVWTEZE— R%& EZ Mode

EIT9D

ASSIGN. 221 v F RERTE Off

ASSIGN. 321w F RRE Off

ASSIGNABLE 424 vF FBE Off

ASSIGNABLE 521 vF *KBE Off

RETR& > SERPEEBEP: V3 Yy MNY—U%EERTSD  LensRET

RS Ly oL 1— (BETRELIER)
COLOR TEMP.7R% >/ ROA NSV R%Z5600KD T Uty METHRD  Color Temp SW 5600K
A NSV AEEZETD

ASSIGN. 01 v F(CE| D Z TrIREIFHEEE

Assignable SW DEEE HEEE ERERAROIRE

Off RERTE —

Marker IRCDY—N—KRRZEL Y/ FT79% REZRETD

ATW Hold ATW (BEBRRTA MSVR) [CLDRTA MU —
SURREBZERITIT D

Picture Cache EOFv—FvwIalbvOE—REFY / FT79% BREEFRFID

Freeze Mix TRV I RZEETITD -

Focus Mag LRI+ —DAMREZEA > /F TS REZFRRE UL

Zebra CISKRREL Y/ FT79% REZFRRE UL

Shot Mark1 U3y hN—U1ZETIAD -

Shot Mark2 U3y hN—02ZEEIAD -

OK Mark OKNY—U =ik HIFRYT 2 -

ASSIGN. 221 v F(CE|D ZH TAIHEISHERE

ASSIGN. 22 A v FICHREZBID HTIeBR EEHR T 4 —< v bOUIDIRZ BR(E. TORBRODRAA v FD
REEAEDOREN—HUENC EDHDE T, HEEDEID ZTRICASSIGN. 221 v FZYID R D\
BRZBIRATDE—HULET,

Assignable SW D:&E HEaE

Off RERTE
Front Mic ATUFRA DGR, ATUVF /E/SIVEVDIRAS
Marker INCDN—D—RRZELV/FTID

THAFTTIVAA v FICHEEZEIDHTS



Assignable SW DRE #&HE

Picture Cache ) EOFv—FvvValvIE—RELY /FTFD

Zebra TISKRESF Y/ FTITD

Digital Extender P) BIFTDEOE VA V=T T—RAF Y RFIF IO RXF 45— CBK-CEO1DE
EIC, BEILAMEZAL Y 4793

b)FIZIVI O RT 2V —HEEDNOND EEIFE. U

a)Picture CacheZA g 45&E. XZ1—D F-YETARRRCET A,

OPERATION >Rec Function(d##%) (JL—%
) (TIED. BECEHLEDFET,

ASSIGN. 1/3X1 wvF, ASSIGNABLE 4/5X4 v F&COLOR TEMP.
R VICEID S TETREISHERE

Assignable SW DRTE #EE EEERARDIREE
Off REE -
Front Mic AT UARAERR, ATUA (F) / B/ HJBEERFID
(A7) ZYDITWZ D
Marker INCDY—H—FREAY/ FTITD BEZRFID
Last Clip Delete EfllciRE Ulco Uy TZHEIRT 8 -
ATW gT;VZD(QEDiE)%TT'\U/r NS VR) BE=REFV /7 BREZFRFLEFEWV
ATW Hold ATWICKRD MDA M\S U ARTEEZRFIT D -
EZ Mode %)LPZDERATION STLCSDFREICEDWVWCEZE— RZERT REEFRIFID
Turbo Gain OPERATION >Gain Switch >Gain TurboMiREICED HREEREE ULEW
WCH—INTA U ZETT D
Rec Review Lo lUE1—%RTITD - o
Rec SCERBAMABILEEERITITD - 11t
Picture Cache EOFv—FvvIalUvIE—REFY /FT9d BREZRFKID %
Freeze Mix TU—=XZ VI RZERITIT D REZRE UIEW I
Spotlight %‘— KPAURE—REARY T4 NMIRE/HRT REZFFITD l'l'
Backlight FT—bPAURE—RZNVISA NIHRE/RRT D BREZRFID gﬁ
EVF Mode Ea1—J7AV5—BERDEE (V) /H53— (4 HEERFID A
) ZYID|A D %
BRT Disp BELNLEREL>S, 135 REERET D it
Histogram ERNITLERELT Y T TTB REERIET D il
Lens Info WERRERTDT J. X—F—Fm. J1— NEnk REEREI D
YIDZ %
Zoom Tele/Wide D U7 b@ERML > XEARHC. ASSIGNABLE 4(C  —

Zoom Telet¥BE%Z. ASSIGNABLE 5(CZoom Widet&hE
E)%ﬂ%“ﬂ%ﬂbéﬁté (<4>. <5>DEERFDHFFRRY
)

Zoom Wide/Tele JUTILBERINL » XEAEFC. ASSIGNABLE 4(C —
Zoom Wide#EgE%, ASSIGNABLE 5(CZoom Telet&hE
ZENZNEIDHTD (<4>. <5>DREFOHERRT

2)
Manual Focus Assist RIAPIWITH—NATPIANEBEZA > /A TID  BREZRFTID
Focus Mag LRI+ —NAMEREZE A /FTID REZEFRFF LIEW
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Assignable SW DRTE #EE EEERAROIREE

Zebra CISKRZELY /FTTD REZRRF LIEW

Lens RET BIFEDCBK-CEO1ZEE U CHASIIAT VY3V —
Zw hEEREULTVDBEIC. UV—VETAESER
eI
AAXSIORATVY a3V hMEGLUTOLEWES
[F. ITD#AE
SOBEPEREBER . Y3y MNN—U %IRRT D
EELS : Ly oLE 21— (BETREERES)

Return Video @ BIFEDCBK-CEO1ZZEZE LCAXSI AT Y3 —
Ty hEEHEUTVREAIC. UY—VETTESER
NEES)

Return Video2 ROV AT LIRIRFATY . RE. #EELE B A, -

Return Video3 ROV AT LERATY . R, #aELEFE Ao -

Return Video4 FRDY AT LERATY . R, #aELEFE Ao -

Shot Mark1 3y N—I1Z2Z2FA0 -

Shot Mark2 U3y hNN—02Z2EEA0 -

OK Mark OKNY—U%Z5CiR/HIFRYT D -

Color Temp SW 3200K  7RDA KNS R%E3200KD T Uy METHRDA M\ REEFET D
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OpenSSLICDWT

LIERICIE. OpenSSL Toolkit TEFAT $/csbIC OpenSSL Project ICK > TRFESNEY T
T I 7 HEZFRNTVET (http://www.openssl.org/)o

OpenSSL License

* Copyright (c) 1998-2008 The OpenSSL Project. All rights reserved.

*

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

E3

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

*

* 2. Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in

* the documentation and/or other materials provided with the

* distribution.

*

* 3. All advertising materials mentioning features or use of this

*  software must display the following acknowledgment:

*  "This product includes software developed by the OpenSSL Project
*  for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
%

* 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
* endorse or promote products derived from this software without

*  prior written permission. For written permission, please contact

* openssl-core@openssl.org.

%

* 5. Products derived from this software may not be called "OpenSSL"
*  nor may "OpenSSL" appear in their names without prior written

*  permission of the OpenSSL Project.

*

* 6. Redistributions of any form whatsoever must retain the following

* acknowledgment:

* "This product includes software developed by the OpenSSL Project
*  for use in the OpenSSL Toolkit (http://www.openssl.org/)"

OpenSSL [CDWWT

R

183



*

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT TAS IS" AND ANY

* EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR

* TS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
*NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

* OF THE POSSIBILITY OF SUCH DAMAGE.

5

* This product includes cryptographic software written by Eric Young
* (eay@cryptsoft.com). This product includes software written by Tim
* Hudson (tjh@cryptsoft.com).

*

/

Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

* All rights reserved.

E3

* This package is an SSL implementation written

* by Eric Young (eay@cryptsoft.com).

* The implementation was written so as to conform with Netscapes SSL.
%

* This library is free for commercial and non-commercial use as long as
* the following conditions are aheared to. The following conditions

* apply to all code found in this distribution, be it the RC4, RSA,

* |hash, DES, etc., code; not just the SSL code. The SSL documentation
* included with this distribution is covered by the same copyright terms
* except that the holder is Tim Hudson (tjh@cryptsoft.com).

%

* Copyright remains Eric Young's, and as such any Copyright notices in
* the code are not to be removed.

* |f this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.

* This can be in the form of a textual message at program startup or
*in documentation (online or textual) provided with the package.

w

* Redistribution and use in source and binary forms, with or without
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* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. All advertising materials mentioning features or use of this software

* must display the following acknowledgement:

* "This product includes cryptographic software written by

*  Eric Young (eay@cryptsoft.com)"

*  The word 'cryptographic' can be left out if the rouines from the library

* being used are not cryptographic related :-).

* 4. |f you include any Windows specific code (or a derivative thereof) from

* the apps directory (application code) you must include an acknowledgement:

* "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

%

* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS" AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE

* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY

* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
* SUCH DAMAGE.

E3

* The licence and distribution terms for any publically available version or

* derivative of this code cannot be changed. i.e. this code cannot simply be

* copied and put under another distribution licence

* [including the GNU Public Licence.]

*/

OpenSSL [CDWWT
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